TUNING GUIDE — PC LINK TCFl.exe & TCFI LOG.exe

A OFF ROAD USE ONLY = NOT LEGAL FOR SALE OR USE IN CALIFORNIA OR ON
POLLUTION CONTROLLED VEHICLES.

A DESIGNED FOR RACING - CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING.

Part Num Application Engine Type MAP Sensor Type

17800 2014-2016 Touring Twin Cam — NA Engine Use OE 1 Bar

17801 2016-2016 Touring Twin Cam — Turbo (15psi) Inc — 2 Bar Sensor

17802 2014-2016 Touring Twin Cam — Turbo (21psi) Inc — 2.5 Bar Sensor

17803 2014-2017 Softall Twin Cam — NA Engine Use OE 1 Bar

17804 2014-2017 Softall Twin Cam — Turbo (15psi) Inc — 2 Bar Sensor

17805 2014-2017 Softall Twin Cam — Turbo (21psi) Inc — 2.5 Bar Sensor

17808 2017-2020 Touring M8 — NA Engine User OE 1 Bar

17809 2017-2020 Touring M8 — Turbo (15psi) Inc — 2 Bar Sensor

17810 2017-2020 Touring M8 — Turbo (21psi) Inc — 2.5 Bar Sensor

17811 2018-2020 Softail M8 — NA Engine Use OE 1 Bar

17812 2018-2020 Softail M8 — Turbo (15psi) Inc — 2 Bar Sensor

17813 2018-2020 Softaill M8 — Turbo (21psi) Inc — 2.5 Bar Sensor

17818 2021-2023 Touring M8 — NA Engine OE 1 Bar
(2021-2024 Ultra)

17819 2021-2023 Touring Turbo Engines Incl - 2 Bar Sensor
(2021-2024 Ultra)

17820 2021-2023 Touring Turbo Engines Incl 2.5 Bar Sensor
(2021-2024 Ultra)

17821 2021-2024 Softail Models Natural Aspirated Engines OE 1 Bar

17822 2021-2024 Softail Models Turbo Engines Incl 2 Bar Sensor

17823 2021-2024 Softail Models Turbo Engines Incl 2.5 Bar Sensor
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&2 OVERVIEW - Our Racing EFI system has been designed for offroad racing use in the “King of the
Baggers” racing series. Each Racing ECU has been designed to plug directly into the factory HD harness

/\ All of the applications listed above require the use of version 23.6+ of the PC_LINK.exe
tuning software and version 19.99+ of the TCFI_LOG.exe logging software. All software is available for
free on our website: daytona-twintec.com.

/\ AUTO-TUNE is included in all of our EFI systems = To enable AUTO-TUNE, the wideband 02
sensors must be installed in the exhaust AND closed loop must be enabled in the tune. After the engine is warm
and close loop becomes active, AUTO-TUNE learns fuel trim corrections. To apply the fuel corrections to the
tune, the uploaded from the ECU and applied to the tune (AUTO-TUNE adjust the front and rear fuel tables).

A IMPORTANT NOTE: Even though Auto-Tune will tune your motorcycle “out of the box”. You must be
willing to do some basic tuning before relying on the AUTO-TUNE feature. This means that you must verify
that the tune on your motorcycle functions at a basic level before relying on the AUTO-TUNE feature. Your
engine must start and run without popping and blowing black smoke. Use the built in M8FI data-logging
combined with TCFI_LOG.exe to monitor the tune. M8FI tune adjustments are made via PC_LINK.exe.

A IMPORTANT NOTE: Occasionally new features are added. To take advantage of a new feature, you
MUST send us the ECU for an update. We want to avoid any issues with customers updating via the internet.

/\ Data Logging is automatically enabled when the engine is running. The ECU continuously records
60 minutes of engine data in a loop, overwriting the oldest data with new data. To access this recorded data, use
the TCFI_LOG.exe Data Logging program.

/\ Tuning, monitoring, and data log playback are performed using the USB-C Interface integrated
into the ECU. Connect the USB-C interface directly to a USB port on your PC (refer to the M8FI GEN 9
System Diagram). ECU tuning adjustments are made via the PC_LINK.exe software. For live data monitoring
or reviewing automatically recorded logs, use the TCFI_LOG.exe software

/\ ECU Diagnostics are conducted using the Live Data View feature within the TCFI_LOG.exe software.
Current ECU error codes automatically clear once the issue is resolved. Historical ECU codes can also be
cleared manually.

R Twin Cam (TCFI7-G8) & M8 (MS8FI G8 & G9) EFI SYSTEM DIAGRAM
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Twin Cam (TCFI7-G8) & M8 (M8FI G8) EFI SYSTEM — WEGO & USB INTEGRATED INTO ECU
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CONNECT TO OEM
ENGINE HARNESS

BOSCH LSU 4.2
rear sensor

BLACK WIRE - GROUND

BLUE WIRE SENSOR R DYNO CONNECTION

WHITE WIRE - SENSOR F DYNO CONNECTION

BOSCH LSU 4.2

M8 (M8FI G9) EFI SYSTEM — WEGO & USB INTEGRATED INTO ECU

BOSCH LSU 4.2
redr sensor
WHITE WIRE - SENSQR F DYNO CONNECTION

BLUE WIRE SENSOR R DYNG CONNECTION

BOSCH LSU 4.2
front sensor

CONNECTTO
OEM ENGINE HARNESS
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ﬁ CAUTION: Proper tuning of the G9FI system requires proficiency with PC operations,
Sfamiliarity with Microsoft Windows programs, and a solid understanding of basic engine tuning and
fuel injection concepts. Users must also have access to standard test equipment and Harley-
Davidson® factory service manuals.

TUNING CLASSES AVAILABLE =2 CALL 386-304-0700 FOR DETAILS.
m HOW TO Download and Install Software and Device Drivers

1 — Visit the software download page: https:/daytona-twintec.com/software/

2 - Navigate to the section: “MS8FI - TCFI - VRFI -- EFI Stand Alone - PC Software”

3 — Download the original TCFI Software Installer: Look for: TCFI Software Installer - Install
First - EXE

4 - Run the original TCFI Software Installer: Execute "TCFI_Software_Installer.exe".

5 — Download the software update: Scroll down further on the page and find " M8FI G8/G9 and
TCFI7 ONLY - Software UPDATE. Install Second — EXE ". This update provides the latest software
necessary for the G9 ECU.

6 - Run the software update: M8FI-TCFI7_SelfInstallUpdate 236-1999 030225 G7G8G9.exe. When
prompted that the publisher could not be verified Click RUN, Click Extract, Click Yes to allow the App to make
a change to your PC and finally Click Yes to All to confirm file replace.

Important: Ensure you install the TCFI Software Installer package FIRST, before running the update.

MS8FI - TCFI - VRFI -- EFI Stand Alone - PC Software

TCFI Software Installer - Install First - EXE @ VRFI Only - Software Installer - Install First - EXE @
TCFI Tuning and Logging Software Installation Package 19.5/19.3 - exe dowjload VRFI Tuning and Legging Software Installation Package - exe download

TCFI4/5/6 ONLY - Software UPDATE - Install Second - EXE (X)  VRFIONLY - Software UPDATE - Install Second - EXE ®
Auto Install - TCFI Software Update 19.57/19.9 - REQUIRED for TCFI4 / 5/ 6 Auto Install - VRFI Software Update 15.7/15.61- REQUIRED for VRFI

TCFI4/5/6 & VRFI 15.2 - Config Examples - Download ZIP VRFI 15.7/15.61 - Config Examples - Download ZIP @
Example configuration/setup files for TCFI and VRFI (tune/logging - for TCFI sw rev Example configuration/setup files for VRFI tune and logging software v157 and

19,57 ONLY and VRFI sw rev 15.2) 1561 ONLY

OLD - M8FI - TCFI7 ONLY - Log SW Config Examples - Download @
ZIP

Example configuration/setup files for the TCFI_Log software for the M8FI and

TCFI7 ECU's (Mote: Only the logging version 19.93 utilizes this update — PC_Link

v20.4 and newer and TCFI_LOG.exe ¥19.97 and newer does not require config

files).

MB8F| G8/G9 and TCFI7 ONLY - Software UPDATE. Install Secofd -
EXE
Auto Install EXE - 03/03/25 This download updates - M8FI/TCFI7 Software Ufjdate
PCLink.exe to v23.6 and- TCFllog.exe to v19.99 REQUIRED for MBFI/TCFI7
G7/G8/G9 — Download and Run this self-extracting EXE file - AFTER 19.5/19.4 is
installed via the TCF Installer. Be sure to run the TCFI Installer package (aboye)
FIRST = pricr to running the update.

MB8F| - G8/G9 - Dyno/Race Tunes - Download ZIP @
Example G8/G9 Race Tunes. After you unzip this file -to view, open the .dat

(tune)using the latest PC_Link.exe (v23 or higher) or .log (log file) using

TCFI_Log.exe (v19.97 or higher) - 02/11/25

/\ YouTube software install video and overview is available at: https:/youtu.be/QQCByMf6wpk
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Q, PC LINK TCFI.exe APPLICATION

Scalars, Tables, Functions and Basic Tuning Procedure

A Before you begin, we recommend that you read the installation and setup documentation, available for
download at: daytona-twintec.com

- TCFI7-G7_MBS8FI-G7_NONIntegrated Install setup.pdf (Separate WEGO and USB interfaces)
- TCFI7-G8_MS8FI-G8 Integrated Install Setup.pdf
- MS8FI_G9_Integrated_Install_Setup.pdf

/\ You MUST perform the initial setup as outlined in the install document prior to starting the vehicle.

/A\ RUNNING the SOFTWARE
- After a successful software install: PC_LINK and TCFI_LOG software exe files are located at:
Windows (C:) > Program Files (x86)>Daytona TwinTec>TCFI_Software

—> The default directory to save your tune and log files is located under Documents or My Documents.

Y2
d - The TCFI_Launcher.exe icon should be located on the desktop.

Double click on the shortcut and a window will open listing the two programs available to run (Tune and Log).

If the shortcut is not located on the desktop, you can locate it in TCFI Software folder and place the shortcut on
desktop.  C:\Program Files (x86)\Daytona TwinTec\TCFI Software
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.TCF\ Software Selection X

SELECT THE TCFI SOFTWARE TO LAUNCH
PC LINK TCFI LOG

SETUP AND TUNING DIAGNOSING AND TESTING

mun

o
]
PR

Zrem.
5 LE
|

04 | Lo tieg [ 5

CHECKING SOFTWARE UPDATES:
This Software Version: 19.5 Visit Our

Latest Software Available: UNABLE TO VERIFY Website
Check internet connection.

USB Driver Version found: 2.12.28

USB Driver is not the latest version OR Internet not lable to
check server version. Click to install

UPDATE USB DRIVER NOW

EXIT

ECU setup/tuning click the icon image to the LEFT - PC_LINK_TCFl.exe.
Data logging and other special features, click the icon image on the RIGHT—=> TCFI_LOG.exe.

/\ For the initial ECU setup/tuning, you will need to access the PC_LINK_TCFI.exe program.
/\ ALL G7, G8 & G9 ECU’s require the use of version 23.6+ of the PC_LINK.exe for tuning and v19.99+
of TCFI_LOG:.exe logging software. The new software now saves the setup options in the tune file and ECU.

A G7, G8 & G9 - This is the hardware generation of the product. Each generation functions the
same, however we have integrated the Wideband and the USB into version G8 & G9.

A To enable communication between the PC, and ECU, the power to the ECU must be turned on (some
bikes have both an on/off switch near the twist grip and a main switch). After the power is turned on, the two
RED O2 Status LEDs will turn on.... indicating that the ECU has been powered on.

A Speed up ECU read/flash time: Set the COM port latency (delay) to 2ms using the PC Device Manager.

The current version of PC-LINK (23.6) has incorporated some new features which makes tunning easier:

- Opening and editing older file versions = eliminates switching back and forth between PC-Link
versions (Note: Older file types will not have some of the latest new & advanced parameters).

- New compare option = The tuner can now see the difference between 2 files (tables and functions only)

- New configuration/option pop-up window —> setup and configuration info is now stored with the file.

- Increased resolution = additional table rows and columns

- 3D view button = use this button to view your table in 3D or go back to spreadsheet mode

- View Functions — View configuration items that previously were not available to view.

- ScantRead ECU and Scan+Program ECU = simple one click buttons to Read or Program your ECU

- TCFI_LOG.exe: Scant+View Live Data or ScantDownload Logged Data = easy to use single click
buttons that allow you to view live data on your motorcycle or download previously logged data.
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EDITING, CREATING and SAVING TUNE FILES

After initial setup, tuning an engine often requires multiple edits using the PC_Link TCFI.exe software. Start
by opening a saved tune file from your PC or reading the current tune directly from the G7, G8, or G9 ECU.
Make the required edits. When prompted, always click "Yes" to save your changes. After editing, save your
modified tune file to your PC before uploading it to the ECU. Before saving, update the User Data Area in the
Edit Basic Module Parameters section.

Helpful tips for managing your files clearly:

e Include customer details and date in the filename (e.g., JSmith 23-Ultra-465cam-stkinj.dat).

e Create a dedicated folder for tuning files.

o Take screenshots or print out tables and parameters.

o Keep detailed notes on changes and filenames.

/\ Important Notes:

o Basic Windows file management skills are required. Unfortunately, we can't provide technical
support for the general use of a PC. We recommend practicing using copy/paste and the right
mouse button.

o The PC software (both PC_Link_TCFl.exe and TCFI_Log.exe) was created with a Microsoft
programming language from 1998. In Windows OS 10 or 11, occasional issues may arise, such as
screens not appearing or displaying incorrectly. If this occurs, simply retry the command or
restart the software (after saving your file). This occurs due to an OS interpretation error.

ACRONYMS USED IN THIS DOCUMENT

ACR - automatic compression release; eases starting by slightly opening valves

AFR — air fuel ratio; ratio of air to fuel in combustion, controls engine efficiency

BCM - body control module; manages electrical functions and security system

BLM - block learn multiplier; wideband O2 learning adjusts long-term fuel delivery per tuning cell
BTDC - before top dead center; timing reference before piston reaches top

CL - closed loop; ECU actively adjusts fuel using feedback from O2 sensors

DTC - diagnostic trouble code; indicates specific faults detected by ECU

ECM/ECU - electronic control module/unit; manages engine operation parameters
ECT - engine coolant temperature; monitors coolant temp on certain Harley models

ET - engine temperature; measures cylinder head or engine component temperature
ETC - electronic throttle control; uses electronic signals instead of throttle cables
FUNCTION - table linking one ECU value to another (e.g., as temp 1, fuel |)

G7, G8, G9 — Daytona Twin Tec ECU series; current versions include G4-G9

IAC —idle air control valve; controls engine idle (not used with electronic throttle)

IAT - intake air temperature; air temp entering engine, influences fuel calculation
LONG TERM FUEL TRIM - also called BLM(Block Learn Multiplier); learned value adjusts long-term fuel delivery per cell
MAP — manifold absolute pressure; sensor measuring intake manifold vacuum/pressure
MSFI — Milwaukee Eight Fuel Injection ECU/system; EFI specifically for M8 engines
NORMALIZER - Reference value used for X/Y axis lookups in tuning functions and tables
PCM - powertrain control module; another term for ECM/ECU managing engine/trans
PW — pulse width; duration injector stays open, controls fuel amount

PWM - pulse width modulation; controls devices by varying electrical pulse timing
SCALAR - single number adjusting ECU setting; think of it as a single adjustment knob
TABLE - organizes ECU data in spreadsheet form, e.g., fuel vs RPM/throttle position
TB — throttle body; controls air entering engine based on throttle input

TCFI — Twin Cam Fuel Injection ECU/system; EFI for Twin Cam engines

TDC — top dead center; highest piston position in cylinder, used for timing reference
TPS — throttle position sensor; monitors throttle opening percentage

TGS — twist-grip sensor (or TGA actuator); measures rider’s throttle twist position

USB — universal serial bus; standardized connector for devices to computer

VSS — vehicle speed sensor; measures wheel or transmission output shaft speed

WOT - wide open throttle; fully open throttle, maximum engine airflow
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DOWNLOADING and UPLOADING DATA

/\ G8/G9 ECMs connect directly into your PC using the included USB-C cable. On these units, both the
AutoTune/Wideband O2 System and the USB interface is integrated into the hardware.

Our other ECM’s: G4, G5, G6 & G7 utilize a separate USB interface, P/N 102004, to communicate with the
ECM. The USB interface connects to the four terminal Deutsch data link connector that is built into the
AutoTune Wideband WEGO harness. The USB Interface has a switch that selects the operating mode, you must
use the TC88A And All Others switch position. DO NOT use the OE diagnostic port to program our ECM.

Turn the bike on, DO NOT START the engine = Turn the ignition key switch and the engine run/stop switch to
the “ON” position. This provides power to our ECM. Some HD models only have a engine run/stop switch.

Both PC_LINK.exe and TCFI_LOG.exe have the ability to automatically Scan and Connect to the ECM. For
this to function, the motorcycle must be turned on, the ECM installed and connected via USB to the PC.

PC_LINK.exe 2 Scan+Read ECU: One click to Read your ECM. To read the file from your ECM, click:
SCAN+READ ECU. Do not forget to save your file after the file has been read.
Scan+Program ECU - When you are finished editing the tune file, reprogram by clicking Scan+PROG ECU.

ECU connection and tune download

Eﬁ Twin Tec -- PC Link ECU Editor - HD W-TWIM -- TCFI & MBFI --v23.2 . [m] s
File Setup Mew ECU Edit.Szalars Edit.. Tables Edit.. Functions iew.Functions Port Setup - ECU Scan+READ ECU Scan+PROG ECU
Help
TP: From here you can... Fesd ECU X
. r Reading FLASH 1 |
Open a Saved Setup File -or- READ ECU T T Fiemware I0: M3 TSE2 S8ar Gen 8 STU Prog Rev 2008 01T €1 2024

If this is a new installation: |
1) Set the VIN (all models) ‘

3 o

2 Set the Odometer(CAN Bus models) —I
3) Cable operated throttles must calibrate the TPS using TCF_Log software
4 Drive-by-wire must calibrate the electronic throttle

5] Set the speedometer frequency. |

Please select Basic Mode or Advanced Mode. Do you want to Auto Connect to the ECU?

Basic Mode displays fewer adjustment menus. Note: If the ECU is not found - itwill take about 30 seconds to scan all
ports- and then contiol will be returned to the program.

Yes No I

This aption can be changed from the Menu at any time.

Do you want to OFEN 3 saved TUNE file from the PC?

BASIC ADVANCED

Yes

Before adjusting a tune file, verify that:
e Your engine is in good condition (without) mechanical or electrical issues
e Ignition system works well; if not, replace spark plugs, wires & coils (if necessary)
e Prior to installing our ECM that the OEM ECM was functioning without and issues or DTC’s.

e Perform the system installation and initial setup as described in the install and setup guide, available for
download on the daytona-twintec.com website.

e Watched the instructional video on YouTube: https://youtu.be/QQCByMfewpk

e Read this tuning manual to gain a basic understanding of how the tuning/logging software works
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BASIC CONCEPTS — PC_Link_TCFI.exe

/\ The top menu bar contains the items that will use to tune the engine.

£ - PC Link ECU Editor -- HD V-TWIN -- TCFI & MBFI -- v23.6 - 0 G9 MB-465cam__ READ2_spk.dat
File Setup Mew ECU  Edit...Scalars Edit...Tables  Edit...Functions ‘iew. . .Functions Port Setup - ECU Scan+READ ECU  Scan+PROG ECU Help

TOP MENU BAR ITEMS
@ File Menu Bar

Open saved tune files, Save Tune files, Edit Config file (old method to configure the software, no longer used
with the latest hardware), Print various items of interest, Configure — Units and Program Options (new
method to configure the software, saved in the tune and tune file), Open recent files (reopen recent files)

s Setup New ECU Menu Bar
- Setup New ECU -> Edit TCFI or MSFI VIN - Enter the Vin

/\ Caution: The body control module (BCM) may not allow starter engagement if the ECM is programmed with an
incorrect VIN. The speedometer will also display a VIN error message. If your bike is equipped with RDRS. You must
program your VIN into the ECU. If the correct vin is not programmed the RDRS/ABS module will illuminate the red
trouble light on the speedometer and the ABS and Traction Control Lights will remain illuminated when the bike is moving.
Once the VIN is programmed Each time your bike is started the ABS and Traction Control Lights will blink, and they will
turn off after the bike starts moving

- Setup New ECU ->Edit TCFI or M8FI Odometer Setting — enter the Odometer reading.
The ECM, BCM and Speedometer store accumulated odometer mileage.

/\ Caution: if you program a higher odometer value, the odometer display will the higher value. If you
mistakenly program the wrong odometer value, and it is higher, the only solution is for the Harley-
Davidson dealer to replace the speedometer and BCM and any other modules that might store the
speedometer value. If this unfortunate mistake occurs, all modules will have to be replaced at the same
time, otherwise any one of the modules with the incorrect odometer information will update the
speedometer to the incorrect value.

-> Setup New ECU ->Calibrate ETC System — Run the ETC auto-calibration routine (follow the instructions
on the screen, the initial test takes about 150 seconds to complete.
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£2 - PC Link ECU Editor -- HD V-TWIN -
Setup New ECU Edit, .. 5calars Edil
Open File Setup Mew ECL =l et =1
FE————— Edit TCFI ar MSFI YIN - 1

Edit TiCFI or MEFI Odometer Setting - 2
Calibrate ETC System - 3

i -- PC Link ECU Editor - HD ¥V-TWIN -- TCFI & MBFI

Edit... Tables Edit

Edit PC Link Software Config File{OLD)

Configure - Units and Program Options (NEW)

Load Compare File BEISil: ".lliE.'W MEIIjE‘-'

Print Moduls Parameters v Advanced Yiew Mode - Recommended

Print User Functions

Print 2D Table: .

Print 3D Tabie Special - Read Connected ECU ETC Parameters
Print Setup...

Special - Debug Parameters
v 39 MB-465cam_ READZ_spk.dat

++va_17x26_startendtable_v2.dat Configure - Units and Program Options
Exit
Conﬁgure - Units and Program [ Configure Units and Program Options - m} x
Options: Your chowe of units and options Temperature Pressuse AifFuel Ratio (AFR)
are programmed into the ECU and saved @ [Fahrenheit  In-Hg & Gasoline AFR
with your tune file. When opening or € Celsius ¢ kPa  Lambda
reading a file, these values are
g . ? pr Senser . MAX PW Auto Calculation Speed Density
automatically updated based on the @ 1 Bar NA- inHG or kPa c True & True
settings in the file. Note: The new ECU L€ Eax Rmiin ks Daty & False “ False
ine i i " 2.5Bar Turbo - kPa Onl
Setup ‘I'Olltlll.e 18 fully explamed (Step by - ar tume e Front CYL - Fuel Multipler Log - G9 - Debug Values
step) in the install and setup document. 3 Bar Turbo - kPa Only & Front Mult Fuel ¢ Swap Output
. . . " Front Alpha Fuel  Normal Output
* Fahrenheit or Celsius units
G9 - Debug EEPROM
* In-Hg or kPA pressure units I Diagnose EE
« AFR (10—19) or Lambda (070 —1. 1) Auto Connect to ECU Auto Port Scan Debug Comm Mode
© True @« True " True
°1 Bar, 2 Bar, 2.5 Bar or 3 Bar Map & False  False & False

* Front CYL — Fuel Multiplier choose Display ETC Parameters

from either Front Mult Fuel or Front & True L} e
Alpha Fuel. If - Front Mult Fuel is O False

chosen the Front Cyl Fuel Table becomes

a multiplier of the Rear Cyl Fuel Table
and no change equals a value of 100. If — Front Alpha Fuel is chosen, the Front Cyl Fuel Table becomes a
second Main Fuel table (independent of the Front Fuel Table).

Basic Mode and Advanced Mode — Advanced Mode is always selected; this mode shows ALL tuning
parameters.

Special — Read Conneted ECU ETC Parameters and Special — Debug Parameters — Normally only used by
DTT Tech Support.

@ Edit...Scalars Menu Bar

Scalars are single values, switches, injector size, rev limits, etc. When you click on Edit...Scalars in the main
window, a sub-menu opens and revealing Basic Parameters — Scalars, Advanced Parameters — Scalars and User
Input/Output — Special Functions. All of the items in these menus are single values(scalars).
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Rear Oyl Tuning OMset (St 08 [

VS8 Frequency Mz} st 100KPH Y575

F Enable Lo

S, 6th Gear Rato (APMKPH] 748
™ Automatic Nominal Idle IAC Update Mode.
I Anti-Stall IAC Mode WEGO Wermup Time P50 s [134
I~ Drake Ovenide [ETCITOW onhy)
¥ Enable TwinCool Parameters s (LS &
Craming Revs 83 [T Norminal Idle IAC Steps (15:5€) [

Darking Aove 1 02 8 rocommerdd o v YL SYNG arars st | 11 €00l Parameters [ bike Is equipped with b

Fan On Temp Below VSS 203267 degf) |21
R St Fan On Temp Aliove VSS (221275 deg ] [244
e s (e 60| Specd for sbove Fan Scilings 62 MP1Y |15
DL Edit...Tables  Edit...F e N ]
- e 3 0240 seconds) |90
eogine off (221-167 deg F) [299 ‘

Basic Parameters - Scalars (G, | srmacisa| remosan
Vb User Data Stored in Tune - 112 chars
Advanced Pararmeters - Scalars b e Qs
Orig Tune Inj Size [gmisce) e
New bo] Size [gmisee] T m"“‘"","l‘:;‘; ;’:’_‘I‘!‘g’”""""' Base PW Factor [535
I_ISE[" InputIDUtput - SFIEI:lal Funl:tllzlns NOT USED BY SW - CALC - MAX INJ P ot MAX RPM LIMIT (mseq) 20,69 File CRC0x [0
Note e wew B .
LTy — x 13 User Functions - o x
Advanced Parameters
Warm Eng Temp (100-257 deg ) [Z05 Min njacr m-;v,:m Imsed 7 ETC "S.".Jo""é'ﬁ..,. = User Input User Output
Engine Warmap Time (70260 S) [173 Mie Integrator Galn [1-63] 0 ETC Rate - Clese e i s .
—— _ hebid S @ Data Log Only (Default) @ Off (Defauly
Hot Soak Tomp (122257 deg ) [T75  AFR Integrator Gon 2127) [% S = d
Hot Seak q [s0 0.0-1.0) T  Ignition Retard  RPM And TPS Based Switch
Dela TPS Galn [1-25] k m:(::;: L..c.-qwn APM [250
ey rrodirr S ety e m‘:‘:;:;:.;um [2as0  Ignition Kill  NOS Trigger
Enlean Decay Rate (2-50) [25 MAXMIN-BLM Fuel Leaming ]
K e Ma T8 L 0  Stage RPM Limit RPM On (100 RPM steps) | 3000
] m&‘:gﬂ L) Foel Addet pot PRIK Poctor 12). [} Knock Seasor - Max TPS
Aoy A R w10 = Stage RPM Limit (100 RPM 5800 [5500
oo (o - H [ ——————————————— jatm T [ 9 RPM Off (100 RPM 5500
wea 5 25
# eaa A AIWOT Uimhs M Trte TSP Read K Facr o) 7 A ool User Retard TPS On (%9 90
WOT AFR Monttor - TPS Enable % ET Spack Retard K LOW (09) DURS Eabte £
Min 25 - Nk 70 o~ ’i* ET Range = 160-220F - Linear B User Retard (0-10 deg) 0 PS Off 80
Mlin i uexizoon | ETsmnemacucnen 7
Retard = MAX Low + Calc High Mini VSS (M [20—
0K | Cancel I Restore Defaults l — (MPH)
oK ear wvmcmmll] Restore Detaults |

# Edit...Tables — The same procedure is used to edit and modify all Tables and Functions

Tables contain multi-row & multi-column data. Two normalizer inputs (X,Y) are looked up to determine the
output cell (Z2). These are often called Tuning Maps. In the example below, X=RPM and Y=in-Hg and Z=Spark.

Table editing occurs using standard Windows copy and paste operations. First select/highlight cells to modify
and then click the right mouse button to access the Modify Cell Pop Up Menu.

Multiple methods can be used to select cells to edit: Dragging the mouse with left button down or you can click
on a cell and use the arrow keys, you can also select all cells in the table by clicking on the top left corner
normalizer cell, individual rows and columns can be selected by clicking on the corresponding normalizer.

After cells are selected, you can enter a new value or you can right click the mouse to access the Modify Cell
Pop Up Menu. Modify Value: Enter a value, notice that the presence of optional sign (+ or -) or percent (%)
characters affects the outcome of the Modify Value command. Multiplier: Uses percentage math.

Note: Pressing the + or — Keys (or P or M) can also modify the selected values based on a values pre-defined in
the Modify Cell Pop Up Menu (Adjust + and Adjust -)

Data Export and Import — Our software supports the ability to paste/export or copy/import table data to or
from another application such as Microsoft Excel. Arrange the program windows so that both the source and
destination are visible (one on the left side of the screen and the other on the right side seems to work best). To
export from PC Link TCFI to Excel, select a range of data on the spreadsheet grid. Right Click and choose
Copy from the menu or press Ctrl+C together to copy the information. In Excel, choose your gride area and
click Paste from the menu or press Ctrl+V together to paste the information. When you are done working,
reverse the procedure.

A\ Tip: To view the table in 3D, click the button 3D View. You can rotate the 3D chart display for a better view of a particular
region by dragging the mouse while holding the left mouse button down.
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Edit. .. Functions View, . Functions Port Setup - ECU

Spark advance

Frant Cyl - Main Fuel
Modify Value Rear vl - Main Fuel

Multiplier BFR Commanded - Closed Loop Target - FronkfRear

Copy  ChrH-C MAXIMIN - BLM Fuel Learning Allowed - Closed Loop

Frank Cwl - BLM Fuel Updates - Closed Loop Learn (ECU READ

Paske Chrl+V
Rear Cyl - BLM Fuel Updates - Closed Loop Learn (ECU READ)

Undo  Ckrl+Z
Relo  Ch+Y APPLY - Fronk/Rear BLM Fuel Learning - Recommended - Front ALPHA {ZL)

Apply ORMLY Front BLM Fuel Learning -- Fronk Cyl Main Fuel (CL)
Apply ORLY Rear BLM Fuel Learning -- Rear Tyl Main Fuel (CL)
Reset - BLM Fuel Front/Rear Adjustment Tables OMLY (CL)

adjust + ) P Increment
adjust - | M Decrement

PC Link ECU Editor -- HD V-TWIN -- TCFI & MBFI -- v23.6 - 0_G%_011725_2018 Turbo_7psi_465_62_2?BAR_FINAL. dat

| PopUp Edk 30
| Advance Table - Cells - 2 Bar Map - kPa r— ‘ Ve |

WPaiRPM | 750 | 1000 [ 1125 | 1260 | 1375 | 1500 | 1760 | 2000 | 2250 | 2500 | 2625 | 2750 | 2875 | 3000 | 3250 | 3500 | 3760 | 4000 | 4250 | 4500 | 4750 | 5000 | ss00 [ i
14 1065 1505 15.75 15.75 15.75 15.75 1575 1505 15.75 15.75 1575 1505 15.75 15.75 1575 15.75 15.75 15.75 15.75 1575 1575 1505 15.75 :

26 1065 | 19.62 17.86 17.86 17.86 17.86 1786 1786 17.96 19.62 1962 1962 19.62 1962 19.62 19.62 19.62 19.62 19.62 1962 1962 1962 19.62

38 1065 | 17.86 17.86 17.86 17.86 17.86 17.86 1786 17.86 17.86 1786 17.86 17.86 17.86 17.86 17.86 17.86 17.86 17.86 17.86 1786 1786 17.86

50 1065 | 17.86 16,63 16.63 15.75 15.75 1065 1065 1198 12.76 1276 1276 12,76 12,76 12,76 12.76 12.76 12,76 12.76 1276 | 1276 1276 12,76

62 1065 | 17.86 16.63 16.63 15.75 15.75 1065 1065 1188 12.76 1276 1276 12,76 12,76 1276 12.76 12.76 12,76 12.76 1276 1276 1276 12.76

bl 1575 1575 1575 13.64 12.76 11.88 100 1100 1.00 11.00 100 1100 11.00 11,00 100 | 11.00 11.00 11.00 11.88 1188 1188 1168 11.98

89 1796 1575 1575 11.88 10.65 10.65 9.24 924 1135 12.23 1223 1223 12.23 1311 13.11 13.11 13.11 13.11 14.34 14.34 [EETRRRRTET) 14.34

101 17.86 15.75 15.75 11.88 10.65 10.65 9.24 924 1047 11.53 1153 1153 11.53 1153 11.53 11.53 11.53 11.53 11.53 11.53 11.53 1153 11.53

113 1593 13.81 13.81 994 8.53 853 5.01 5.01 6.95 6.95 6.95 6.95 6.95 6.95 6.95 6.95 6.95 65.95 65.95 6.95 6.95 6.95 6.95

125 37 378 1.67 167 167 167 0.26 061 1.67 167 167 273 5.19 5.54 5.54 5.54 5.54 6.25 11.35 11.35 11.35 11.35 11.35

137 167 3.78 1.67 167 167 061 0.26 0.61 1.67 1.67 167 167 3.08 484 6.95 6.95 8.36 1293 12.93 13.99 13.99 13.99 13.99

149 167 378 1.67 1.67 167 061 0.26 061 1.67 1.67 1.67 0.61 273 273 4.84 695 8.36 12.05 13.46 14.34 16.45 16.98 17.69

161 167 2.55 1.67 167 167 061 0.26 114 1.67 1.67 167 0.61 1.67 273 4.84 6.95 10.47 12.05 13.46 1434 16.45 15.05 15.57

173 167 0.61 0.61 0.61 0.61 0.26 0.26 114 1.67 1.67 1.67 0.61 0.61 1.85 378 4.84 748 8.36 8.36 8.36 9.94 9.94 9.94

185 167 061 0.61 061 0.61 0.26 0.26 114 1.67 1.67 167 061 0.61 0.44 1.85 273 3.25 4.13 4.13 413 413 413 413

187 167 061 0.61 0.61 0.61 0.26 0.26 114 1.67 1.67 167 061 0.61 0.44 0.97 0.97 237 3.25 325 3.25 237 237 237

1.67 0.61 0.61 0.61 0.61 0.26 0.26 114 1.67 1.67 167 0.61 0.61 0.44 0.97 0.26 1.14 1.14 114 0.97 0.97 0.97

Spak Advancs Table
¥ avis i contraled by MAP Sensor selection [1/2 or 3 bar] and the MAP Urit choice [KPA or irHg).
Malch Map Sensor ssiection 1o the ECL and Map Sensor HW.
Map Sensor selection is Located in the menus: Setup Mew ECU-> Configure Urits and Program Dptions

Min -6.25 - Max 306 degrees  Step Size=0176

Sawe - Update Data

Debug - Value0.176 - fadv_thl_MAX, exasis_rpm_spk_26, eyais_map_17 - 0x434D - Iu154

Cancel - No Update

Spark Advance Table Example -- 2 Bar M8 Turbo
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s Edit...Tables > Spark Advance Table

Edit table data by modifying the numeric data in the spreadsheet grid. Enter values or right click for Modify
Cell Pop Up Menu.

The Spark Advance Table consists of 26 columns (X) from 750 to 7,000 RPM and 17 manifold pressure (MAP)
rows (Y). The values for MAP automatically rescale based on the type of MAP sensor that is selected. It is
recommended to use the unit kPA for MAP. We also support In-Hg, but we do not recommend it because the
values are reversed for what is used on a vacuum gauge. Note: 10 In-Hg corresponds to a high vacuum
deceleration or idle condition and that 30 In-Hg corresponds to wide open throttle (WOT). Advance values (Z)
are in degrees and they must be between -6.26 and +38.6 degrees.

/\ Important Notes: Normalizer values (X,Y) that are less than or greater than the min/mx normalizer values
automatically use the corresponding Z lookup value in min or max cell. For example: RPM X value is 430rpm
this is less than 750 so it will use the value in the 750 RPM column. If greater than 7000, it will use that value.
After you have edited the table, you must save the modified tune information into memory. Click the button
labeled: SAVE — Update Data. Click Yes to save your edits to buffer memory. If you click NO, your table
edits will be lost.

# Edit...Tables > Rear Cyl - Main Fuel Table

Alpha-N is the technical term
for this fuel lookup table
(Throttle Position vs RPM). The
Alpha-N table values are in MAX RPM Limit (100 RPM steps) 5000
percent units.

Rear Cyl Fuel Table (also named Main Fuel Table)

Base Injector Pulse Width (msec) W
The values in this table are ™ BASE INJ PW - AUTO CALC ENABLE
multiplied with the Base e o7 bk o i I
Injector Pulse Width value PR
located in Edit...Scalar Basic

Parameters — Scalars to

determine the injector pulse
width.

After the engine enters Closed
Loop, the values in this table
then corrected for the desired

Lo | phaN Table - Cells - Rear Oyl Percent Base PW

&

ereee| &

T 000 | w25 [ 3% | w315 | 1500 | t1s0 | 200 |
Ws me 19 %5 %5 28 a0

3
3| §

[T T T I T N TR TR U]
% B9 W9 25 NS A9 WS
2 A W 75 X8 28 20
N M M N5 N5 A5
B B W WD ¥ WS WS
LT T Y T T R 7 I U]
LT T I T T T R T S T T T ]

e

SEEESBBEEESE

0 69 469 460 60 68 460
509 508 SM0 S0 59 59 S0
535 S5 N5 55 85 98
555 55 55 55 55 555 555
9 500 S0 S0 S0 59 85
M5 558 %9 S5 S5 M8 88

520 5 S0 B0 69 69 MS
525 53 50 60 60 69 60
539 53 510 60 649 60 6iD

pRoSRRPREEnCMN Y

655 670 655 660 670 660 620 660 640 615 60 60 @0 S &

air/fuel ratio (set by the AFR Enter -7.5% to reduce each cell in selection by 7.5%
Commanded — Closed Loop Target table). The Enter +15% to increase each cell in selection by 15%
learned values for the front and rear cylinders are [15

saved in Long Term Fuel Trim Tables (Front/Rear

Cyl - BLM Fuel Updates [Block Learn Multiplier]) to arrive at the corrected injector pulse width. The
correction is applied based on the information learned by the wideband oxygen sensor signal.

From a practical standpoint, the Alpha-N table must be within about +35% of the required values for the
AutoTune system to successfully correct the injector pulse width based on closed loop feedback from the
wideband exhaust gas oxygen sensor.

The Rear Cyl — Main Fuel table is automatically corrected when the Apply - Front/Rear BLM Fuel command
is executed (after riding the bike in closed loop and reading in the tune from the ecu — updates are in the tune).
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# Edit...Tables 2 Front Cyl — Multiplier vs Main Fuel Table

If the option for Front Mult Fuel is selected, the Front I
Cyl Fuel Table becomes a multiplier of the Rear Cyl
Fuel Table. The front cylinder trim table values are in
percent units.

A value of 100 in this table means to use 100% of the
Rear Cyl Fuel Table Pulsewidth Value for the Front
Cylinder Pulsewidth.

Another way to look at this is that the calculated
injector pulse width for the front cylinder is generated
by multiplying the value from the Rear Cyl Fuel Table
by the Front Cylinder Multiplier/Trim value to arrive at
the front injector pulse width.

The front cylinder trim table is automatically corrected
when the Apply - Front/Rear BLM Fuel command is
executed (after riding the bike in closed loop and reading in the tune from the ecu).

s Edit...Tables = Front Cyl — Main Fuel Table

If the option for Front Alpha Fuel is chosen, the Front Cyl Fuel Table becomes a second Main Fuel table
(independent of the Front Fuel Table). The Front Cylinder — Main Fuel Table values are in percent units.

The values in this table are multiplied with the Base Injector Pulse Width value located in Edit...Scalar Basic
Parameters — Scalars to determine the injector pulse width. After the engine enters Closed Loop, the values in
this table then corrected for the desired air/fuel ratio (set by the AFR Commanded — Closed Loop Target table).

The learned values for the front and rear cylinders are saved in Long Term Fuel Trim Tables (Front/Rear Cyl -
BLM Fuel Updates [Block Learn Multiplier]) to arrive at the corrected injector pulse width. The correction is
applied based on the information learned by the wideband oxygen sensor signal.

From a practical standpoint, the Alpha-N table must be within about +35% of the required values for the
AutoTune system to successfully correct the injector pulse width based on closed loop feedback from the
wideband exhaust gas oxygen sensor.

The Front Cyl — Main Fuel table is automatically corrected when the Apply - Front/Rear BLM Fuel command
is executed (after riding the bike in closed loop and reading in the tune from the ecu — updates are in the tune).

Frorﬁ?’oyﬁear Front Alpha-N Table - Cells - Front Cyl Percent Base PW CW‘;::TD Compers D View

TPSIRPM 750 | 1000 | 1125 | 1250 | 1375 | 1500 | 1750 | 2000 | 2250 | 2500 | 2625 | 2750 | 287
0 2.0 10.0 10.0 10.0 10.0 10.0 10.0 10.0 10.0 10.0 10.0 10.0 10,4
2 2.0 9.5 9.5 10.0 10.0 10.0 10.0 10.0 10.0 10.0 10.0 10.0 104
5 9.0 95 9.5 10.0 10.0 11.0 125 1.0 110 1.0 130 115 124
7 9.0 10.0 10.0 10.0 12.0 120 12.0 12.0 12.0 12.0 13.0 12.0 124
9 2.0 1.0 110 1.0 125 U5 135 135 135 13.5 135 15 124
12 12,0 125 130 13.0 145 155 175 175 155 14.0 140 14.0 144
14 14.0 14.0 140 155 175 175 175 195 205 205 205 210 20
17 175 17.5 175 17,5 195 195 19.5 19.5 19.5 235 255 215 27
20 19.0 19.0 19.0 19.0 21.0 22.0 220 220 26.0 300 29.5 295 30.
22 225 225 225 22,5 22.5 235 235 235 27.0 30.5 330 30.5 31
25 255 255 255 255 255 255 200 290 29.0 325 340 20,0 20!
27 30.5 305 30.5 30.5 30.5 305 305 305 335 37.0 300 105 414
30 27.0 31.0 310 31.0 325 34.0 345 34.0 38.0 0.5 410 405 434
% 30.0 34.0 310 34.0 35.0 37.0 375 37.0 40.5 430 435 435 45,
45 30.0 340 3490 34.0 35.0 365 100 430 455 470 405 50.0 50.1
65 30.0 340 340 34.0 35.0 385 435 16.0 485 48.5 405 50.0 50.1
a0 30.0 34.0 34.0 34.0 35.0 38.5 435 46.0 48.0 48.5 40.5 50.0 50.1

= .

Main Fuel Table - Front Cyl - Wahies in this table. multiply against the BASE Inj P to detemine injectos pulse width
Final P\/ i3 also affected by BLM and Startup/Fuel Multipher functions.

Changes ta this table will affect ALL fusl relsted tables.
These values are moified when applying leamed BLM vals.
Highes values add fuelervichen). Lowes values remave fuslientean)
Under Boost when MAP is greater than 105k pa - fuel pulsewidth is increased 4,2% per PSI Save - Update Data
Min1 - Max 125
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s Edit...Tables > AFR Commanded — Closed Loop Target — Front/Rear Table

The AFR (air/fuel ratio) table sets
the desired air/fuel ratio under
various operating conditions. The
air/fuel ratio values are used as a
target for both the front/rear injector
pulse width calculation (explained
above). Typical petrol air/fuel ratios
are 13.0 for idle, 13.5 for cruise, and
12.5 for wide open throttle. To
prevent engine overheating, avoid
lean air/fuel ratios exceeding 14.0
under cruise conditions. This table
should not be adjusted during the
initial tuning process.

Important Note - related to turbocharged applications:

If 02 sensors are installed in-between the exhaust port and the Turbo, the pressure in the exhaust pipe will
cause the O2 sensors to show leaner than they actual. This is a normal, due to read slightly different,
depending on the pressure. This can skew the air fuel that is reported by the sensor up to a full air fuel point.
Example: AFR reported by the sensor in the pipe before the turbo shows 11.4:1 and the actual AFR after the

turbo is 12.2.
This is not a huge issue - it is important to run a commanded AFR that is slightly richer than you desire to

achieve the expected results.

’ Edit...Tables = Max/Min BLM Fuel Learning Allowed Table — Closed Loop (CL)

The values are in percentages. They
represent the maximum and minimum
allowed Long Term Fuel Trim Learning in g
a given cell for both the Front and Rear &
BLM learning tables. The Front/Rear Cyl g
— BLM Fuel Updates tables are limited >
g

(+/-) to the range of values that are set in s . e
this table. A value of 4 in this table allows | & Of o1
for the fuel to be adjusted a maximum of 0 & = S

either 4% positively or negatively. It is
recommended to expand the entire
learning are in this table to +-30% when
initially dialing in a new combination.
Once you understand where the reversion

Save - Update Data

areas are located, the values in this table
should be reduced to lower values. Typically 4 in reversion areas, 10 at lower throttle openings, 20 in the

midrange and 15 at WOT.
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’ Edit...Tables = Front Cyl/Rear Cyl BLM Fuel Updates — Closed Loop Learn (ECU READ)

These two tables contain Front/Rear Cyl BLM fuel Updates - Closed Loop Learn
the Long-Term Fuel Trim l - l
Learning / BLM Fuel There are 2 BLM tab
Updates that occur for the Onyrones st hy
. Rear Cyl BLM table p
Front and Rear Cylinders. functions as the fron
Long-Term Fuel Trims are oil.

also called BLM (Block
Learn Multiplier), because
the learned value

BLM Fuel Updates|

multiplies against the main | = & & &
fuel table values. The : : :
BLM values are in percent e om om
units and represent a im w
correction factor required e ow ow
to maintain the air/fuel o "

ratio set on the AFR table. BLM values
are updated based on closed loop feedback
from the exhaust gas oxygen sensors. BLM learning values are limited in range from 50% to 150%. A value of
100 equals no change or use 100% of the main fuel table value. A value of 110 adds 10% additional fuel to the
corresponding cell in the main fuel table, a value of 90 subtracts 10% of fuel from the same cell. BLM cell
values 0 and 1 are special function values. A cell with the value of 0 forces Open Loop (no BLM learning. This
can be useful in operating areas where severe exhaust reversion causes incorrect sensor readings. Cells with the
value of 1 disable Long Term Fuel Trim learning in that cell, this means that each time the engine is restarted,
the learning in this cell is automatically reset to 100. Learning is limited in the cell to the Max/Min BLM Fuel
Learning Allowed Table Value that corresponds with the cell. This is the preferred method for dealing with
exhaust wideband O2 learning reversion.

Exhaust Reversion: Front/Rear Cyl BLM fuel Updates — Special Considerations

Sometimes you will see
hlgher or lower than The AutoTune algorithm is not perfect. | will
eXpeCted values in some bring you close to where you should be; it will
cells in the table. It is show where your fuel table needs more or

.. . less fuel, but you need to refine the results.
not realistic for adjacent
cells to have values that
vary wildly. The reason
for this variation is

B 1000 | 1126 | 1260 | 1378

Exhaust reversion. T e 1w w m wm | w

BLM Fuel Updates - Rear Cyl - Closed Loop - Cells

3
RF
g
E
A
g
8
5
£

Reversion is the term for
anegative pressure wave
that can suck ambient air
back into the exhaust
and cause an erroneous
lean AFR indication. Reversion effects typically occur at one or two different rpm levels and can be noticeable at
idle, part throttle low RPM cruise, and decel. Open drag pipes suffer from reversion effects. Please note that if
you use drag pipes or other open pipes, auto-tuning may not be possible at idle or part throttle due to reversion
effects. To tune the engine, you might be forced to force open loop in these areas.

TR
i

90 100 100 100 100 100 100 100 100 100 100 100 100 9 98 9 9
e
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When you see values that vary by a large amount, you may need to manually adjust and smooth the cells around
that peak or dip (edit the 8 cells around the spike — and the spike itself), then run the engine again, covering the
area of interest; download the data and the engine map and analyze. This is an iterative process, you may need to
repeat it, but in the end, it will bring you very close to the ideal fueling. In some instances, you may need to
disable AutoTune feature by using the 0 and/or 1 values.

After operating the engine, read the ECU by choosing the Scan+Read ECU feature and examine the BLM
tables (Edit...Tables = Front Cyl/Rear Cyl BLM Fuel Updates — Closed Loop Learn (ECU READ)). If the
data in the BLM tables looks good (Front and Rear) use the sub command under Edit...Tables > Apply —
Front/Rear BLM Fuel to apply the learning changes to the Rear Cyl - Main Fuel Table and Front Cylinder
Fuel Table. It is recommended to apply to both tables; however you can choose to apply the learning to only the
front or rear table. After running any of the Apply BLM Table commands, after the tables are modified, the
BLM table cells will automatically return to 100% and the learning process will start again. If you don’t like
the learning in the BLM tables, you can choose the command Reset - BLM Fuel Front/Rear Adjustment Tables
ONLY (CL) to resets all BLM cells in the Front/Rear BLM tables to 100% (without applying the learning).

Applying Front/Rear BLM Fuel Corrections

Apply Rear + Frant BLM Tables ®
i Using this sction will 3pply both the Resr BLM [Block learm PC Link ECU Edlitor -- HD V-TWIN -- TCFl 8 M8FI -- v23.2 - 0.g9_011425_135_106_Turbo10psi_18_applyFinal dat
multiplier) values to the M_uir:: UEQI Tx:g:: and ];\Dmuw[h:rrzm! d
Front sl Fubl Table nd thr reseline ot and ren 6M Setup New ECU Edit...Scalars Edit..Tables Edit...Functions View,..Functions Port Setup - ECU Scan+READ
Taops 533 Fave st s perfoamed o ava e nomnd T
Front/Rear BLM Adjustments. \ Spark Advance
Cancel
: \ Front Cyl - Multipler vs Main Fuel
pply Rear + Front BLM Tables b \ Rear Cyl - Main Fuel
This action will apply the rear BLM (block learn multiplier) \\
! values to the Main Fuel Table and apply the front ELM
caleulation to the front ginder trim tables and then - ™, AFR Commanded - Closed LOOP Target - Front/Rear
renarmalize the font and rear BLM tables. h ~ \
.‘\\“\ \ - 1 -
— \ \\ MAX/MIN - BLM Fuel Learning Allowed - Closed Loop
ety Front 8L Table L " ~ ~\ Front Cyl - BLM Fuel Updates - Closed Loop Learn (ECU READ)
This action will apply the front 8LM (block leam multiphier) - \\ Rear Cyl - BLM Fuel Updates - Closed Loop Learn (ECU READ)
B values to the front cylinder trm table and then renormalize S \
! the front BLM table. -] ~ 5
APPLY - Front/Rear BLM Fuel Learning - Recommended - Front MULT {CL)
Cancel T e
pRO——o— " Apply ONLY Front BLM Fuel Learning -- Front Trim Thl ONLY (CL)
Apply ONLY Rear BLM Fuel Learning -- Rear Cyl Main Fuel (CL)
This action will apply the rear BLM [block leamn multiplier)
Bi, vl sl Tl MR ons s e el "\ Reset- BLM Fuel Front/Rear Adjustment Tables ONLY {CL)
ok || cenen
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S Edit...Functions — /e same procedure is used to edit and modify all Tables and Functions

Functions are two column tabular data, 2D maps. An input normalizer value (top row, X) gives an output value
(bottom row, Z). Before you can edit one of these tables, you must either open a data file or download data from
a ECU unit. Each table consists of 17 columns with the upper row corresponding to the independent variable
(throttle position, engine temperature, elapsed time, or IAC position.

Function editing occurs using standard Windows copy and paste operations. First select/highlight cells to
modify and then click the right mouse button to access the Modify Cell Pop Up Menu.

Multiple methods can be used to select cells to edit: Dragging the mouse with left button down or you can click
on a cell and use the arrow keys, you can also select all cells in the table by clicking on the top left corner
normalizer cell, individual rows and columns can be selected by clicking on the corresponding normalizer.

After cells are selected, you can enter a new value or you can right click the mouse to access the Modify Cell
Pop Up Menu. Modify Value: Enter a value, notice that the presence of optional sign (+ or -) or percent (%)
characters affects the outcome of the Modify Value command. Multiplier: Uses percentage math.

Note: Pressing the + or — Keys (or P or M) can also modify the selected values based on a values pre-defined in
the Modify Cell Pop Up Menu (Adjust + and Adjust -)

Data Export and Import — Our software supports the ability to paste/export or copy/import function data to or
from another application such as Microsoft Excel. Arrange the program windows so that both the source and
destination are visible (one on the left side of the screen and the other on the right side seems to work best). To
export from PC Link TCFI to Excel, select a range of data on the spreadsheet grid. Right Click and choose
Copy from the menu or press Ctrl+C together to copy the information. In Excel, choose your gride area and
click Paste from the menu or press Ctrl+V together to paste the information. When you are done working,
reverse the procedure.

Functions - Edit and Use

w - PC Link ECU Editor -- HD V-TWIN -- TCF| & M8FI -- v23.2 - 0_g9_011425_135_106_Turbo10psi_18_applyFinal dat - o

File Setup New ECU Edit...Scalars Edit..Tables Edit...Functions Views,..Functions Port Setup - ECU Scan+READ ECU Scan+PROG ECU
Help

Accel/Decel - Fuel Multiplier vs TPS Rate Of Change

Priming - Fuel PW vs Engine Temp - Fuel Injected Prior to Cranking

Cranking - Fuel PW vs Engine Temp - Fuel Injected During Cranking

Target AFR Enrichment - Multiplier vs TIME + Global Cold Start Enrichment
Target AFR Enrichment - Multiplier vs ENGINE TEMP + Global Cold Start Enrichment

Front/Rear Cylinder - Cold Start Enrichment - PW Mult vs Time
Front Cylinder - Cold Start Enrichment - PW Mult vs Engine Temp
Rear Cylinder - Cold Start Enrichment - PW Mult vs Engine Temp

Global Fuel P\W Enlean/Enrichment vs Intake Air Ternp

Idle RPM Commanded vs Engine Temp
Idle Air Control - Position vs Engine Temp

Idle Air Control - Start Position Adder vs Engine Temp

Examples of editable functions
A second file is opened to compare
Red cells correspond to invalid sensor readings

ET (degF) 3 2 61 30 118 147 176 205 234 262 291 oo A ETE EOE S e
11 1" n 1 n

P [msec) 65 56 26 23 8 14 12 10 11 1 11 1

You can edit the numeric data corresponding to the dependent variable on the lower row of the spreadsheet grid.
A typical 2D table is shown. Some of the engine temperature cells are highlighted in red. These red cells
correspond to extreme sensor readings. After you have edited the table, you must click Save Update Data to
save your changes into memory.
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@ Short description of each editable Function — Edit...Functions

Accel/Decel - Fuel Multiplier vs TPS Rate Of Change - The values in this table are percentages and allow
you to add or remove tip in fuel based on the change in throttle position (delta).

—> Value of 100 does not add or reduce fuel, no change in fuel.

- Values ABOVE 100% add fuel, ex 110 = add 10% more fuel. This function is similar to adjusting the
accelerator pump on a carburetor - useful for adding fuel on quick throttle transitions (can reduce momentary
hesitation or cough when quickly accelerating).

—> Values BELOW 100% remove fuel (useful for reducing exhaust back fire when closing throttle). Adjust
after primary tuning has been completed.

A The MAIN Fuel Table is a big part of the accelerator pump system, if the main fuel table is setup too lean,
on heavy tip-in the AFR will be lean and it will be difficult to add enough fuel using the Accel Fuel Multiplier
function.

% The Accel/Decel — Fuel Multiplier vs TPS Function also works in conjunction with several other Scalars
(Edit...Scalars> Advanced Parameters — Scalars).

Scalar = Delta TPS Gain (higher numbers give a bigger change on fuel tip in/out, be careful, to large of a value
will cause the fuel pulse width at idle to oscillate, recommended 7 or lower).

Scalars = Enlean or Enrich Decay Rate (controls how fast fuel is added back after a enlean event or how fast
fuel is reduced after a enrichment event). Events are controlled by the change in TPS.

Priming - Fuel PW vs Engine Temp - Fuel Injected Prior to Cranking - Values in this table are pulse width
in msec. Priming Fuel Pulse Width is based on Engine Temp. This is the amount of fuel that is injected as the
engine is first starting to turn over. Note: If you add too much fuel here the engine could kick back with a hard
start that sounds like detonation when warm. If too lean, the engine might not start smoothly when cold or the
engine might take an extra revolution before starting. Once the engine is rotating at greater than 50rpm, the
ECU switches over to the Cranking — Fuel PW vs Engine Temp Table.

Cranking - Fuel PW vs Engine Temp - Fuel Injected During Cranking - Values in this table are pulsewidths
in msec. Cranking Fuel Pulse Width is based on Engine Temp. This is the amount of fuel that is injected
AFTER the engine starts to turn over. Too much fuel, and the engine will blow black smoke after startup. Too
little fuel(lean), and the engine might not start reliably or the engine might backfire when it is turning over.

Target AFR Enrichment - Multiplier vs TIME + Global Cold Start Enrichment - Values in this table are a
percentage AFR multiplier based on time. Works in combination with Function: Target AFR Enrichment -
Multiplier vs ENGINE TEMP. The multiplier values in this table are looked up vs Time (seconds), these value
multiply with the value in the table: Target AFR Enrichment Multiplier vs ENGINE TEMP. Result modifies
the AFR or PW for both cylinders, the product of these two table values do two things 1-->If closed loop is
active (modify the commanded AFR) OR 2-->If open loop is active, they globally modify commanded fuel.
Note: If either table value is ZERO - no modification will be added at that Time/Engine Temp. Global =
Modifies Both Cylinders ET=Engine Temp

Target AFR Enrichment - Multiplier vs ENGINE TEMP + Global Cold Start Enrichment — Values in this
table are a percentage multiplier values based on Engine Temp. Works in combination with Function: Target
AFR Enrichment - Multiplier vs TIME. The values in this table are looked up vs Engine Temp, they multiply
with the value in the table: Target AFR Enrichment - Multiplier vs TIME. Result modifies the AFR or PW for
both cylinders, the product of these two table values do two things 1-->If closed loop is active (modify the
commanded AFR) OR 2-->If open loop is active, they globally modify commanded fuel. Note: If either table
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value is ZERO - no modification will be added at that Time/Engine Temp. Global = Modifies Both Cylinders
ET=Engine Temp

Front/Rear Cylinder - Cold Start Enrichment - PW Mult vs Time - Values in this function is a Fuel Pulse
width percentage multiplier based on time. Works in combination with two other functions to provide unique
fuel control to each cylinder: Front/Rear Cylinder - Cold Start Enrichment - PW Mult vs Engine Temp. The
multiplier values in this table are looked up vs Time (seconds), they multiply with the value in the specific table
and this allows for engine temperature-based control specific to the Front or Rear Cylinder. The product/output
of the two tables directly modify Fuel Pulsewidth based on time and engine temperature. Note: If either table
value is ZERO - no modification will occur at that Time/Engine Temperature.

Front Cylinder - Cold Start Enrichment - PW Mult vs Engine Temp - Values in this table are Fuel Pulse
width percentage multipliers based on Engine Temp. Works in combination with: Front/Rear Cylinder - Cold
Start Enrichment - PW Mult vs Time, to provide unique fuel cold start fuel control for the Front cylinder. The
multiplier values in this table are looked up vs Engine Temperature (ET), they multiply with the value in the
table: Front/Rear Cylinder - Cold Start Enrichment - PW Mult vs Time. The product/output of the two tables
directly modify Fuel Pulsewidth for the front cylinder based on Time & Engine Temperature. Note: If either
table value is ZERO - no modification will occur at that Time/Engine Temp.

Rear Cylinder - Cold Start Enrichment - PW Mult vs Engine Temp - Values in this table are Fuel Pulse
width percentage multipliers based on Engine Temp. Works in combination with: Front/Rear Cylinder - Cold
Start Enrichment - PW Mult vs Time, to provide unique fuel cold start fuel control for the Rear cylinder. The
multiplier values in this table are looked up vs Engine Temperature (ET), they multiply with the value in the
table: Front/Rear Cylinder - Cold Start Enrichment - PW Mult vs Time. The product/output of the two tables
directly modify Fuel Pulse width for the rear cylinder based on Time & Engine Temperature. Note: If either
table value is ZERO - no modification will occur at that Time/Engine Temp.

Global Fuel PW Enlean/Enrichment vs Intake Air Temp - Values in this table are percentage multipliers
that modify Fuel Pulse width for both cylinders based on Intake Air Temperature (IAT). A value of 100 does
not modify fuel pulse width, values below 100% Remove Fuel and Values above 100% ADD Fuel. Examples:
100=Do not modify, 110=Add 10% of additional Fuel Pulsewidth, 90=Remove 10%

Idle RPM Commanded vs Engine Temp - Values in this function set the target Idle RPM based on Engine
Temperature. Typically, the target Idle RPM is set higher when the engine is colder. As the engine warms up,
the target Idle RPM is lowered.

—>Final Idle RPM is also modified by: Edit...Scalars=>Basic Parameters - Scalars->Nominal Idle IAC Steps
and by Edit...Functions—>Intake Air Control — Position vs Engine Temp and Functions—>1dle Intake Air
Control — Start Position Adder vs Engine Temp.

A If you have an intake leak, the system might not be able to match the commanded RPM. Typical values:
1300rpm below 60F, 1200 below up to 120F, 1100-1000rpm above 180F

Idle Air Control - Position vs Engine Temp - Values in this function represent BASE commanded airflow
through the Idle Air System based on Engine Temperature (ET). Larger IAC values, typically result in more
idle air passing into the engine and a higher Idle RPM engine speed. IAC values should be reduced as the
engine temperature increases. This table is utilized to set the minimum throttle position for idle (25=2.5%
throttle).

—Final Idle RPM is also modified by: Edit...Scalars=>Basic Parameters - Scalars->Nominal Idle IAC Steps
and by Edit...Functions=>1dle RPM Commanded vs Engine Temp and Functions—=>1dle Intake Air Control —
Start Position Adder vs Engine Temp.
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Idle Air Control - Start Position Adder vs Engine Temp - Values in this function represent additional airflow
through the Idle Air System at startup based on Engine Temperature (ET). Generally, additional air is required
for hot start after heat soak. Immediately after engine start up, engine should reach 1200-1300 rpm and steadily
decrease to command idle speed. If engine RPM is low after start or stumbles before the idle stabilizes, increase
the value in this function at the observed engine temperature. Before the engine idle stabilizes, if excessively
high rpm is experienced, reduce value at the observed engine temperature.

—Final Idle RPM is also modified by: Edit...Scalars=>Basic Parameters - Scalars->Nominal Idle IAC Steps
and by Edit...Functions=>1dle RPM Commanded vs Engine Temp and Functions—=>1dle Intake Air Control —
Position vs Engine Temp.

’ View...Functions — Not editable

These functions are not normally changed during normal tuning. These functions are provided for information
purposes only. To learn, contact Daytona Twin Tec Tech Support for assistance.

Functions - view Dnlv [& -- PC Link ECU Editor -- HD V-TWIN -- TCFI & M8FI -- v23.2 - 0_g9_011425_135_106_Turbo10psi_18_applyFinal dat - =]
File Setup New ECU Edit...Sealars Edit... Tables Edit...Functions View...Functions Port Setup - ECU Sean+READ ECU  Sean+PROG ECU
Help Global Fuel Injector PW Compensation vs Battery Voltage
Global Fuel PW Enlean/Enrichment vs Barometric Pressure
These functions are for display only. To Max Throttle vs RPM
ifi Coil Conduction Time vs Battery Voltage
be modified by DTT staff only. 1y Voltag
M 2 WEGO Sei - Transfer Functi
You don’t need to edit these functions roor Tnsurruncion
Whl Ie tu ning Engine Coalant Temp (ECT) - Transfer Function
Intake Air Temp (14T) - Transfer Function (Low Range)
Contact Tech Support with any Intake Air Termp (AT) - Transfer Function (High Range)
questiﬂns. Engine Temp (ET) - Transfer Function (Low Range)

Engine Temp (ET) - Transfer Function (High Range)

Idle - Max Allowed Error - Positive
Idle - Max Allowed Error - Negative

LU » i .
Example of “view only” function: T Wit e

Cruise Control - Estimated TPSvs Speed

Y Axis - TPS - Fuel Tables - 17
X Axis - RPM - Spark/Fuel Tables - 26
¥ Axis - MAP - Spark Tables - 17

PETTEREERENL ]

WEGO - Transfer Function
Compars

weoow | oo [ o3 [ oe) [ ood | 135 [ 456 [ we0 [ 248 | 280 [ 281 | 343 [ 344 | 3715 [ 406 | 43 | 480 [ 800
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THE TCFI LOG APPLICATION

Overview, real time data view and logging

After TCFI Log.exe is launched, several questions are asked to make it easy to automatically monitor or
download saved data from the ECU. Be sure to turn both the ignition key on and set the engine run/stop
switche ON to provide power to the ECU unit prior to starting the software.

Bis Twin Tec MBFI - TCFI Data Logging Program v19.99 - u] X%
File Scan+VIEW LIVE DATA Scan+DOWNLOAD LOGGED DATA +View Chart View ECU DIAG Codes Special Features Help

TIP: From here you can...
Open a saved log file (File->Open)
Download a log file from the ECU (Communications->Download Logged Data)

View real time engine data (View->View Real Time Data)

Download diagnostic codes (C ications->Download Statistics and Diagnostic Codes

Clear diagnostic codes (C icati Clear Hi | Diagnostic Codes

Do you want to Auto Connect to the ECU?

Note: If the ECU is not found - it will take about 30 seconds to scan all
ports, and then control will be returned to the program.

e |[w ]

You can display real time engine data on an instrument panel type screen by using the command Scan+VIEW
LIVE DATA. Or you can download and display data that has been automatically logged by the ECU by using
the command Scan+tDOWNLOAD LOGGED DATA + View Chart. Data automatically logged by the ECU
must be downloaded before it can be displayed. Anytime the engine is running, the ECU automatically saves
the data. After data has been downloaded, it is automatically displayed on a chart recorder type screen. You can
save this data by using the Save File command from the File menu. You can display a previously saved data file
by first using the Open File command on the File menu and then using the View Chart command on the View
menu.

You can also download, view, and print
engine operating statistics and historical
diagnostic codes by using the Download
Statistics and Diagnostic Codes command
from the Special Features menu.

On the G7 version of the ECU, our USB
interface, P/N 102004, is required for
communication between the PC and ECU.
The USB interface connects to the four
terminal Deutsch data link connector that is part of the WEGO harness. The USB Interface has a switch that
selects the operating mode. For communication with the TCFI, you must use the TC88A And All Others
switch position.
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/\ G8 & G9 ECU versions DO NOT require that additional USB interface; they plug
directly into PC using a USB-C cable that is included in Kit.

@ File> Configure Units — Program Options (NEW)

The old manual configuration file has been replaced with File-> Configure Units — Program Options (NEW).
A dialog box will appear as shown below. You can select the configuration units to use for the software display:
Speed: miles per hour (MPH) or kilometers per hour (KPH), Temperature: Fahrenheit (F) or Celsius (C),
Pressure: inches of mercury (In-Hg) or kilopascals (kPa) manifold pressure units, Injector Data: Pulse width in
milliseconds or duty cycle in percent, Air/fuel ratio in gasoline AFR or Lambda units and the MAP sensor type
1,2, 2.5 or 3 bar. Note: The program remembers the selections you have made.

| Configuration & Units Selection E@@

Speed Pressure AirfFuel Ratio [AFRH)
" MPH *" In-Hg " Gasoline AFR
& KPH « kPa * Lambda
Temperature Injector Data
i+ Fahrenheit " Pulse Width [msec]
" Celsius + Duty Cycle [%) MAP Sensor
* 1 Bar - NA
5¥ +19.94 - Config{Unit info is saved within the datalog file. " 2 Bar - Turbo 14.5psi

If you adjust these values, you must re-open the dataloq file * 2.5 Bar - Turbo 22psi

OR re-upload the log information from the ECU for the change " 3 Bar - Turbo 29psi
to take effect. Be sure to match the ECU MAP sensor type.

" Enable G9 Live Diagnostics OK \

P Scan+VIEW LIVE DATA v REAL TIME ENGINE DATA DISPLAY

When the engine is running, you can display real time engine data on an instrument panel type screen by
selecting the command Scan+View Live Data. Clicking this command will automatically scan and connect you
to the ECU. Please note that real time engine data cannot be directly saved by means of the TCFI_Log.exe
program. However, this data is constantly being logged by the ECU and can be downloaded and viewed via the
command ScantDOWNLOAD LOGGED DATA+View Chart (for example at the end of series of dyno runs).
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[ %1 Twin Tec M8FI - TCFI Data Logging Program v19.91 = (m) X
|

| File Edit Live Data View View and Download Logged ECU Data Port Setup Special Features Help

BARO (KPA)
50 0 70
a0 N+le/ g0
N\ &
s0_~ SPEED % g9

DIAG CODE

USERIN USER
OFF | [OFF

-

20 — =100

-

107 - <110
/" MPH N
0 120

1813 0
FRONT REAR CYLINDER Exit RT View

/ x100 N
. N

(6.9 [ 3.7 |

O=NWaO~N
[ BN RN

Real time engine data is displayed on an instrument panel type layout with round tach and speedometer gauges
and bar graph type gauges for most other parameters. Barometric pressure, any diagnostic codes, status of the
user input and output, and status messages are displayed in additional windows. If the engine is not running
most values will appear as zero.

Displayed parameters include:

RPM - engine crankshaft RPM (numeric value displayed beneath gauge)

VSS — vehicle speed in MPH or KPH (numeric value displayed beneath gauge)

TPS — throttle position (0 to 100%)

TGS — twist grip position (0 to 100%)

MAP — manifold pressure in In-Hg (29.92 In-Hg or 101.3 kPa corresponds to atmospheric pressure)

ECT - engine coolant temperature (On TwinCooled™ models only). Coolant pump and cooling fans
status also displayed.

ET — engine cylinder head temperature

IAT — intake air temperature
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BAT - battery voltage
TIAC —idle air control value in 0.1% throttle position units (higher number means more idle air)

AFR - the air/fuel ratio bar graph has dual pointers. The yellow pointer on the left side is the air/fuel ratio
command (from AFR table). The white pointer on the right side is the actual air/fuel ratio based on the
exhaust gas oxygen sensor reading. Note that the value will remain near 10 until the sensor has warmed
up. Front and rear cylinder AFR values are displayed for all TCFI Gen 7 units when the WEGO IIID is
installed.

BLM - block learn multiplier (main fuel table correction factor based on exhaust gas oxygen sensor
feedback, shown as percent value from 75-125%). Separate front and rear cylinder BLM values are
displayed.

FRONT INJ, REAR INJ — injector pulse width in milliseconds or duty cycle in percent
FRONT ADV, REAR ADYV - ignition advance in degrees BTDC

You can also select the vehicle speed, temperature, pressure, and injector data units used for real time
engine data display and data logging chart display. Use the Configuration & Units Selection command
File=> Configure Units — Program Options (NEW). A dialog box will appear and you can select miles per
hour (MPH) or kilometers per hour (KPH) vehicle speed units, Fahrenheit (F) or Celsius (C) temperature
units, inches of mercury (In-Hg) or kilopascals (kPa) manifold pressure units, pulse width in milliseconds
or duty cycle in percent for injector data, and air/fuel ratio in gasoline AFR or Lambda units. The program
remembers the selections you have made.

M Scan + DOWNLOAD LOGGED DATA + View Chart

You can download and display the data that is automatically logged by the ECU into a chart recorder type
screen. The data logging memory within the ECU stores the last 60 minutes of data at 10 samples/second.
Clicking this command will automatically connect to the ECU and allow you to Download logged data for
review. You can select the length of the data set that will be downloaded. Once data has been downloaded, it is
automatically displayed. The last data logged will appear at the right end of the chart. You can save the data
by using the Save File command from the File menu after closing the chart display (data is not lost by closing
the chart display). You can display a previously saved data file by first using the Open File command on the
File menu and then using the View Chart command on the View menu. Each time the engine is started or shut
off, the log will automatically start a few seconds prior to the engine running and turn off a few seconds after it
stops running.

A Remember - Real time engine display data cannot be directly saved via the TCFI_Log.exe program.
However, this data is constantly being logged by ECU and it can be downloaded and saved (for example at the
end of series of dyno runs). All saved data files use the file extension: .log. It is recommended to create a
separate folder to store these files.
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w. TCEI/MBFI Log Chart - 0_G9_2021_0Ol -testing_150-secs. log
File Edit Datalog Comment  Display Options — Simple  Complex Complex Spark. Complex Fuel  Resek Time  Set' Axis  2Bar MAP Sel

Engine Cold Fuel Cell ECU Diag Code NfV Gear Ratio li 71.9 Sec
Status RPM 1000 RPM/KPH Nominal 1AC [ 21
2.5 100.6
FPM TPS BAROIkPal IAT [dea F)
200
— FPM
1= VS5[KPH]-TR3
——— MAP (kPaj- TR4
1 =——— FrontAdv [deqg)- TRS
500 TPS (%) - TR 180

Front Inj Duty Cycle (%) - TR?
Lambda Command - TRS
5000+ = Front Lambda - TR3

ET [degF)- TR10

140

120
4000+

100
30001 a0
]
20001
1000 M\WWWW
! 20
e "WMWW
0 : 0
0 10 20 30 40 50 B0 70 80 30 100 110 120 130 140 150
Elapsed Time [sec)

K | +]
Trace 1 -LY = 966 Trace 2 - BY - 136 Zc;om Z(t;otrn ’ ﬁf%ml Séri:lprlte Exit Interval | 0.10
IRPM - ENGINE SPEED ~| [IAT- INTAKE ARTEMP ~ ~| I o g . (sec)

Trace 3 - BY = | 0.0 Trace 4 - RY . 40 Trace 5 - BY . 139 Trace 6-RY = 2.8
VSS - VEHICLE SPEED ~| |MAP - PRESSURE | |FRONT SPARK - ADVANCE  ~| [TPS % - THROTTLE/ETC POS ~|
Trace 7-RY_— 328 Traceg-Ry — 0.90  fraceg-py W 136 Trace 10- RY — 212
[FRONT INJECTOR - DUTY % ~| |AFR - COMMANDED ~| |FRONT aFR - AcTUAL ~| |ET- ENGINE TEMP |

You can select up to ten parameters to display and graph. The X axis is always elapsed time. Trace 1 is
displayed in red with its Y axis legends on the left side of the chart. Trace 2 is displayed in green with its Y axis
legends on the right side of the chart. The other trace colors are built into the graph and they are always the
same, in the same order. You can zoom in, zoom out, or zoom all (displays entire data file). At the maximum
zoom in level, approximately 100 data samples will be displayed on the chart. You can use the scroll bar to
move the chart display window in terms of elapsed time. If you hold the left mouse button down within the
chart area, a cursor line appears. The exact values of the selected parameters are displayed above each trace
box. If you want to see use a parameter’s range on chart’s display, the selected parameter needs to be selected as
either trace 1 or 2, or you can select Set Y Axis and setup customer ranges for the signals. When you zoom in or
zoom out, the displayed data will always be centered about the cursor line. This allows you to quickly select and
closely examine an area of interest. As you move the cursor, the current value displayed above each parameters
is updated. If you want to analyze the elapsed time between two events (for example the time required to
accelerate from 0 to 60 MPH), you can move the cursor to the first event and then click on the Reset Time
Display button. You can also print the displayed chart to any Windows printer by clicking on the Print button.
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Data parameters include:

RPM - engine crankshaft RPM

VSS — vehicle speed in MPH or KPH

MAP — manifold pressure in In-Hg (29.92 In-Hg or 101.3 kPa corresponds to atmospheric pressure)
TPS — throttle position (0 to 100%)

TGS — twist grip position (0 to 100%)

AFR CMD - air/fuel ratio command (10:1 to 20:1). This is the AFR value the TCFI is attempting to
maintain.

FRONT AFR, REAR AFR - air/fuel ratio based on the exhaust gas oxygen sensor reading (10:1 to
20:1). Front and rear cylinder AFR values are displayed for all TCFI Gen 7 units when the WEGO IIID is
installed.

FRONT BLM, REAR BLM - block learn multiplier (main fuel table correction factor based on exhaust
gas oxygen sensor feedback, shown as percent value from 75-125%). Separate front and rear cylinder
BLM values are displayed.

TAC —idle air control value in 0.1% throttle position units (higher number means more idle air)
IAT — intake air temperature

ET — engine cylinder head temperature

COOLANT TEMP - engine coolant temperature (on TwinCooled models only)

COOLING PUMP - On/Off pump operation (on TwinCooled models only)

COOLING FANS — On/Off fan operation (on TwinCooled models ony)

FRONT INJ, REAR INJ — injector pulse width in milliseconds or duty cycle in percent

FRONT ADV, REAR ADYV - ignition advance in degrees BTDC

BAT - battery voltage

USER IN — user input displayed as digital (on/off) signal. On means that the input is active (grounded).
USER OUT - user output displayed as digital (on/off) signal. On means that the output is grounded.
CLUTCH - On means that the clutch is pulled in

BRAKE — On means that a brake has been applied

NEUTRAL - On means that neutral light is illuminated (transmission in neutral)

TGS ROLLOFF — On means the twist grip is in the roll-off position

CRUISE ENABLE — On mean the cruise switch is on.

CRUISE ENGAGED - On means the cruise control system is controlling vehicle speed
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CRUISE SET - On means the cruise set button is pressed
CRUISE RESUME - On means the cruise resume button is pressed

ETC PWM - ETC system pulse width modulation command to the TCA motor (+100% range with
negative values below limp back and positive values above)

AAdditional ECU information is displayed at the top of the screen. This data includes:

ECU Diag Code — Normally blank unless a diagnostic code is set.
Engine Status — Statis based on engine temperature — Cold or Warm

Fuel Cell Display —Active cell in terms of RPM and TPS percent at the cursor position. TPS percent is
compensated for idle air. This function is useful for determining what fuel table cell is active at any given
point in time. The same RPM and TPS cell is active in all fuel tables.

N/V Gear Ratio Display — shows the calculated gear ratio (RPM/KPH) at the cursor position. This
function is useful for determining the 6th gear ratio required for Module Parameter setup in PC Link TCFI
for the 6th gear indicator light.

BARO(kPa) Display — current barometric pressure

Nominal IAC Display - Nominal IAC value (value learned by system when engine is completely warmed
up and at stable idle condition).

Interval(sec) — the actual data logging interval in seconds

IMPORTING DATA INTO EXCEL

Data files saved from TCFI Log.exe are in comma delimited ASCII format. You can easily import a saved .log
data file into other programs such as Microsoft Excel for further analysis. You can also view data files with a
text editor such as Windows WordPad. To import a data file into Excel:

1. Start Excel. In the File Open dialog box, select Files of type: All Files (*.*). Then browse for the data file.

2. The Text Import Wizard appears. For step 1, select delimited file type. For step 2, select comma delimiter.
For step 3, select general column data format. Then click on Finish.

3. You can then format the data and save the spreadsheet as an Excel file.

#® SPECIAL FEATURES

Special Features D2ETC Test Mode

The ETC Test Mode command on the Communications menu has two options that allow you to test the
electronic throttle control system without the engine running:

Manual test. Throttle control actuator (TCA) throttle position follows twist grip sensor (TGS) command. This
option is useful for a quick check of TCA operation. Enter “1” to enable ETC manual test mode or “0” to
disable. Then select View Real Time Data on the View menu to view TGS and TPS data.

Characteristic curve. The system plots out the characteristic curve of TCA throttle position versus TCA motor
pulse-width modulated (PWM) drive. This option allows detection of defects such as excessive friction,
incorrect or noisy TPS signals, and broken gear teeth. Refer to Appendix A for more details.
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Special Features 2USER OUTPUT MANUAL OVERRIDE

The User Output Manual Override command allows you to manually override the user output on the ECU. This
command can be used as a diagnostic aid to test accessory systems connected to the user output.

OPERATING STATISTICS

You can also display and download engine operating statistics logged by the TCFI unit. Data logged by the
TCFI unit must be downloaded before it can be displayed, by using the Download and View
Statistics/Diagnostic Codes/ Diagnostic Codes command on the View and Download Logged ECU Data
menu. Once data has been downloaded, it will automatically be displayed. Please note that this data is not
saved.

The data is fairly self-explanatory. Total hours represents the total time that the engine was running. ID
represents the firmware identification. This field typically includes the manufacturer (Twin Tec), model
number, program revision and author's initials, and date. Note that the date is not a manufacturing date code,
just the date for the particular firmware release.

Elapsed time is displayed for 13 RPM bands from idle to 6999 RPM. Note that elapsed time data is rounded off
during each engine run, so the sum of the elapsed time figures may not precisely match the total hours. The
program also displays the maximum engine RPM, time at the RPM limit (in seconds for better resolution) and
the number of engine starts.

Clicking on the Print Statistics button prints a report. When you click on this button, a small data entry screen
pops up and allows you to add a serial number or comment that will appear on the printout. You can also use
the Print command from the File menu.
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TCFI Operating Data

Total Hours 20.35 Maxdmum Engine RFM 5760

I |Twin Tec TCFI Gen 5 Program Rev 1.1 CFS 2012 seconds at RPM Limit 5.1
Engine Starts 67

RPM Band | ldle 1000-1499] 1500-1999] 2000-2499 2500-2099] 3000-3499] 3500-3999

Hours 321 3.54 581 5.27 130 0.43 0.35

RPM Band | 4000-4499] 4500-4999) 5000-5499( 5500-5999) 6000-6499) 6500-6999
Hours 0.21 0.10 0.07 0.0m 0.00 0.00

Historical Diagnostic  [PO107 MAP Rationallty Fault  Trips: 3
Codes P0563 High Battery Voltage  Trips: 7

Histogram | Print Stafistics Exit

Any historical diagnostic codes logged by the TCFI unit are listed along with the number of trips (engine start
cycles) since the individual code was last logged. Codes are automatically cleared after 50 trips.

Customers are often confused about the meaning of the term “trips.” This is an industry standard
terminology. If a code shows 40 trips, it means that the code was set 40 engine start cycles ago, not that
the code has been set 40 times.

You can clear historical diagnostic codes by using the Clear Historical Diagnostic Codes command from the
Special Features menu.

The elapsed time data in the various RPM bands can be displayed in the form of a histogram chart by clicking
on the Histogram button. Color coding of the bars helps to interpret the data. The idle RPM band is blue, normal
operating RPM bands are green and high RPM bands are yellow and red. The chart is automatically scaled for
best display. You can print the chart along with a complete statistics report by clicking on the Print Chart
button.

BASIC TUNING RECOMMENDATIONS AND PROCEDURES
ENGINE STARTING PROCEDURE

With alpha-N fuel control, the proper engine starting procedure must be followed. When the run/stop
switch is turned on, the ETC system runs an auto-calibration routine that establishes the zero (closed throttle)
position. During this time, the check engine light is on and the fuel pump is energized for several seconds,

Daytona Twin Tec 240 Springview Commerce Dr BLD 1-J Debary, FL 32713
Tuning Guide PC_Link_TCFl.exe & TCFI_Log.exe Manual Rev 3.0 (386) 304-0700 www.daytona-twintec.com
5/2025

Page 30


http://www.daytona-twintec.com/

making an audible buzz. Do not press the starter button until the check engine light goes out and the fuel pump
stops buzzing.

We recommend that you let the engine idle for about 20-30 seconds before operating the motorcycle. This
allows the closed loop idle air control system to stabilize idle RPM.

IDLE TUNING

Please note that during the initial period after engine start, fuel control is open loop (no feedback from the
WEGO sensors) and relies entirely on correct values in the Alpha-N table. The TCFI will enter closed loop
AFR control mode after the WEGO warm up time (nominal value of 30 seconds) has elapsed.

To allow viewing and logging AFR data immediately after engine start, turn the ignition switch on but leave the
run/stop switch in the stop position. Wait at least 15 seconds for the WEGO sensors to warm up and then start
the engine. Monitor engine data and status with TCFI Log software.

Allow the engine to idle until it reaches normal operating temperature of 110° C or 230° F. A fan should be
used to direct cooling air on the engine to more realistically simulate actual warm up conditions and prevent the
engine from overheating. If the engine does not start or stalls, please refer to the diagnostic tips at the end of this
section.

Monitor front and rear cylinder AFR and BLM, engine temperature, and IAC values. Keep notes on your
observations of these values. After 30 seconds, the system should be operating in closed loop and maintaining
the desired idle AFR (nominal value of 13.5). The BLM values should remain within the range of 80-120%.

The IAC value should slowly go down as the engine reaches operating temperature and requires less idle air.

BLM values below 100% indicate that the TCFI is removing fuel in closed loop to correct a rich condition.
BLM values above 100% indicate that the TCFI is adding fuel in closed loop to correct a lean condition.

If the BLM values go below 80% or above 120% anytime during the warm up period, the system is running out
of adjustment range and the idle cells in the Alpha-N fuel table should be edited before proceeding with further
tuning.

Download the current setup with PC Link TCFI software and use the Edit 3D Table — Alpha-N Table command
to edit the idle cells in the Alpha-N fuel table. Depending on engine temperature, IAC value and idle RPM, the
TCFI will be using the cells in the 750, 1,000, 1,250, and 1,500 RPM columns and the 0%, 2.5% (IAC between
15-40), and 5% TPS (IAC above 40) rows. You can select all these cells, right click the mouse, and then use the
Modify command on the pop-up menu. Add a percentage corresponding to the BLM error. For example, if the
worst-case BLM value noted was 120%, add 20% fuel by entering +20% (not +20). Likewise, if the worst-case
BLM value was 80%, subtract 20% fuel by entering -20%. Remember to use the Save Table Edits to Buffer
command after editing the table. Then use the Edit 3D Table — BLM Tables — Reset BLM Tables command to
reset all BLM values to 100%. Save the edited setup file to disk and upload it to the TCFI.

As mentioned above, the IAC value should slowly go down as the engine reaches operating temperature. The
IAC value should drop to near the nominal value (15-30 as set under basic module parameters). If the IAC value
stays above 40 or drops below 15, there may be an electromechanical problem with the TCA or a manifold
vacuum leak (very low IAC).

After making any required edits repeat the start test and allow the engine to reach normal operating temperature.
Make sure the engine runs for at least 5 minutes and the status display shows warm closed loop operation
— otherwise BLM values will not be saved.
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The idle tuning step is complete when BLM values stay within the range of 85-115% during the warm up phase
and the TAC value is within the range of 15-30 once the engine reaches normal operating temperature. If these
criteria cannot be met, please contact our tech support before proceeding.

Diagnostic tips if the engine does not start:

I.

Verify that the TCFI is properly installed and set up, that the battery is fully charged, and that the engine is
not flooded from excessive priming caused by repeatedly cycling the run/stop switch during setup.
Disconnect the fuel pump relay and crank the engine to clear flooding.

Try the following starting procedure: set the run/stop switch to run, wait until the fuel pump stops running,
slightly open the throttle, and then press the starter switch. If the engine starts, the problem may be
insufficient air caused by an incorrect IAC value. Please contact our tech support before proceeding.

Ether starting spray can be used as a diagnostic aid. Try starting the engine after an application of ether
spray. If the engine starts and runs at a normal idle RPM, the problem is insufficient fuel. Try increasing the
priming and cranking fuel values by 10-20%. Download the current setup with PC Link TCFI software and
use the Edit 2D Table — ET Based Priming Fuel Table and ET Based Cranking Fuel Table commands.
Select all cells, right click the mouse, use the Modify command on the pop-up menu, and enter +10% (not
+10). Remember to use the Save Table Edits to Buffer command after editing each table. Save the edited
setup file to disk and upload it to the TCFI. Retest and repeat if additional fuel seems to be required.

If larger fuel injectors were installed, cranking and priming fuel values may need to be decreased. Try
decreasing the priming and cranking fuel values by 20%. Download the current setup with PC Link TCFI
software and use the Edit 2D Table — ET Based Priming Fuel Table and ET Based Cranking Fuel Table
commands. Select all cells, right click the mouse, use the Modify command on the pop-up menu, and enter -
20% (not -20). Remember to use the Save Table Edits to Buffer command after editing each table. Save the
edited setup file to disk and upload it to the TCFI.

Try re-installing the stock ECM. If the engine does not start with the stock ECM, there may be an
underlying problem that requires correction. If the engine starts with the stock ECM but not the TCFI,
please contact our tech support for assistance.

Diagnostic tips if the engine stalls:

1.

If the engine momentarily starts, runs for several revolutions (less than 2 seconds), and then stalls, priming
and cranking fuel values may be insufficient to build up the required fuel film in the intake manifold. Try
using ether starting spray or cycling the run/stop switch several times to add additional priming fuel before
starting the engine. If the engine starts normally, you have confirmed that more fuel is required. Try adding
10-20% more priming and cranking fuel as explained in Paragraph 2 in the preceding section.

If the engine stalls after running for several seconds, observe AFR values. To do this you must allow the
WEGO sensors to warm up for at least 15 seconds before starting the engine. You can observe data in real
time or download data logged using TCFI Log. For best results, select the 10 samples/sec download option.
In most cases, the problem is caused by excessively lean AFR. Based on observed AFR values, make
appropriate corrections to the idle cells in Alpha-N table. If the AFR is lean, try adding 10-20% fuel (use the
procedure explained on page 6). If this does not solve the problem, please contact our tech support for
assistance.

In some cases, changes to the cold start enrichment tables may be required. There are independent ET
(engine temperature) based front and rear cylinder cold start enrichment tables. To allow viewing and
logging AFR data immediately after engine start, turn the ignition switch on but leave the run/stop switch in
the stop position. Wait at least 15 seconds for the WEGO sensors to warm up and then start the engine.
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Monitor engine data and status with TCFI Log. Download the logged data. Compare the front and rear AFR
values after engine start to determine if adjustments are required. Refer to the TCFI Idle Tuning Tech Note
for more details.

AUTO-TUNING

The closed loop auto-tuning process consists of operating the motorcycle through a wide range of loads and
speeds while periodically monitoring progress using the PC Link TCFI software. Long rides at constant speed
and load are of no value. The best technique is to very slowly accelerate through the useable RPM range in
every gear, allowing several seconds of operation in each RPM and throttle position-based cell. Also operate the
motorcycle at various fixed speeds likely to be encountered during normal riding. For safety reasons, wide open
throttle runs should be done on a closed course.

We recommend auto-tuning under actual riding conditions. If this is not possible, you can auto-tune on a load
control dyno and use TCFI Log to monitor AFR and other engine parameters.

If AFR values appear very lean (above 14.5), we suggest that you edit the Alpha-N table to add 15-20% fuel to
all cells except idle cells before proceeding. Auto-tuning works best if you start with a slightly rich Alpha-N
table. Download the current setup with PC Link TCFI software and use the Edit 3D Table — Alpha-N Table
command. You can select groups of cells, right click the mouse, use the Modify command on the pop-up menu,
and enter +15% (not 15). Remember to use the Save Table Edits to Buffer command after editing each table.
Save the edited setup file to disk and upload it to the TCFI.

After 1-2 hours of engine operation, download the current setup with PC Link TCFI software and use the Edit
3D Table — BLM Tables — Edit Front and Edit Rear BLM Table commands to examine the BLM tables. Cells
that are shaded red indicate that the system has run out of correction range. Then use the

Apply Front and Apply Rear BLM Table commands to automatically correct the Alpha-N fuel table and front
cylinder trim table. This also resets all the BLM values back to 100% and allows auto-tuning to continue. Save
the edited setup file to disk and upload it to the TCFI.

Auto-tuning is a statistical process. The longer the operating time, the greater the probability that more cells will
be covered. However, even a varied operating cycle can miss some cells. After you use the Apply BLM Table
commands, take some time to examine the modified Alpha-N and front cylinder trim tables. Unless your engine
has some unusual camshaft and exhaust interactions, the tables should appear smooth (with gently rising
slopes). If you spot sharp spikes or dips, these cells have probably been missed during auto-tuning and will
require some manual edits to smooth them into the surrounding terrain.

The Alpha-N table represents percent injector pulse width (fuel flow) before correction for BLM, front cylinder
trim, barometric pressure, intake temperature, and cold start enrichment. You can use the following guidelines
to smooth the Alpha-N table:

1. At part throttle (low TPS%), Alpha-N values in each row will tend to decrease as RPM increases (because
the throttle is choking air flow).

2. At wide open throttle, Alpha-N values in each row will tend to follow the engine torque curve.
3. Inany given RPM column, Alpha-N values must always increase with TPS.

The front cylinder trim table may appear more complex and irregular, with peaks and valleys corresponding to
gas flow interactions within the intake and exhaust system. However, very sharp spikes and dips may require
some smoothing.
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If you edit the Alpha-N or front cylinder trim table to smooth out values, remember to use the Save Table Edits
to Buffer command after editing each table. Save the edited setup file to disk and upload it to the TCFI.

Continue to operate the motorcycle under varying conditions for another 1-2 hours. Then repeat the process of
downloading setup data, examining the BLM tables, using the Apply BLM Table commands, smoothing the
Alpha-N and front cylinder trim tables, saving, and uploading back to the TCFTI as previously described.

Continue this auto-tuning process until most of the BLM cells remain in the 90-110% range.

If spark knock is noted under wide open throttle or throttle roll-on, use PC Link TCFI software to edit the
ignition advance table and reduce the ignition advance 3-5 degrees under the conditions that cause spark knock.
Using the TCFI Log software to examine engine data may be very helpful for determining exactly what
manifold pressure and RPM values were encountered. A common error is to assume spark knock only occurs at
high MAP (manifold absolute pressure) values. Large displacement engines are prone to spark knock at
relatively low MAP values during throttle roll-on. You may need to reduce the ignition advance throughout the
entire MAP range.

FUEL INJECTOR SIZING

Accepted engineering practice is to use the smallest possible injectors (in terms of flow) for best control at idle
and part throttle. The original equipment throttle body and similar aftermarket units with Siamese runners are
subject to fuel imbalance problems between the front and rear cylinders. When the fuel injector duty cycle
exceeds 50%, fuel will start being inducted into the wrong cylinder (i.e. front injector spraying fuel while rear
intake valve is still open). The TCFI system cannot correct this problem.

Table 1 lists conservative horsepower limits based on injector size. You can use TCFI Log software to check
the injector duty cycle at wide open throttle.

Recommended Horsepower Limits

Injector Size Horsepower Limit
4.34 gm/sec (stock) 100 HP

4.89 gm/sec (Screamin | 110 HP
Eagle® P/N 27654-06)

IDLE TUNING CONSIDERATIONS

Some large displacement engines with high overlap/long duration camshafts may not idle properly at the
nominal 1,000 RPM and 13.5 AFR settings used in the standard setup files. You may have to increase the idle
RPM to a higher value such as 1,100 RPM and enrich the idle to 12.5-12.8 AFR.

Download the current setup with PC Link TCFI software and use the Edit 2D Table — ET Based Idle RPM
command to increase the idle RPM. Do not decrease values at the left of the table (corresponding to a cold start
condition) that are already higher than your desired idle RPM. If you significantly increase idle RPM, you may
also have to make corresponding edits to the ET Based IAC Position table. Then use the Edit 3D Table — AFR
Table command and change the applicable idle cells (750 -1,500 RPM at 0-5% TPS) to the desired AFR value.
Remember to use the Save Table Edits to Buffer command after editing each table. Save the edited setup file to
disk and upload it to the TCFI.
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DYNO TUNING CONSIDERATIONS

Auto-tuning using the procedures listed on page 7 will get you within a few horsepower of the maximum
that the engine can deliver. If you decide to do dyno tuning for maximum power, you can experiment with wide
open throttle (WOT) ignition timing and AFR. Please pay careful attention to the following dyno tuning
considerations:

1. Only edit the ignition advance and AFR tables. Don’t edit any other tables (never make any changes to
the BLM or Alpha-N tables once auto-tuning is completed). The usual range for WOT ignition timing at
4,000-6,000 RPM is about 28-34 degrees BTDC. The usual range for WOT AFR is about 12.5-12.8. Some
engines may require a richer mixture, possibly down to 11.5, to avoid detonation problems.

2. The TCFI should be operated in closed loop. Make sure that the engine is warmed up (oil temperature is
in the 150-180° F range) before doing a run and that engine status in TCFI Log shows closed loop
operation. If you have made any table edits, allow one run for auto-tuning before capturing data.

3. Inadequate air flow for engine cooling is a major problem with many dyno systems. Always let the
engine cool off between dyno runs. The use of a separate heavy duty industrial grade fan capable of
generating at least 50+ MPH air velocity at the front of the engine is recommended. You can measure the air
velocity with a handheld anemometer such as Extech P/N 45118 available from Grainger.

4. Use the TCFI data logging capability. Always download data with TCFI Log software at the end of every
run and study the results (use the 10 samples/sec download option). Check engine and air temperatures,
throttle position, manifold pressure, and AFR. TCFI Log is a very powerful tool that can help you identify
potential problems that may be affecting engine performance. Inconsistent dyno test results are often the
result of thermal problems (engine temperature variations or hot soak effects).

5. Dyno exhaust sniffer limitations. Some of the older sniffers monitored CO and CO:. These systems are so
slow and inaccurate that they should be totally disregarded. Modern sniffers from Dynojet and Horiba use a
wideband sensor similar to the WEGO sensor. These sniffers are still subject to erroneous lean readings
caused by reversion of atmospheric oxygen if the probe cannot be inserted past the baffles in the exhaust.
Sensor degradation caused by leaded racing gas is a common occurrence. Another problem is sampling
delay due to the long hose between the sniffer tip and actual sensor. The bottom line is to trust your WEGO
sensors and disregard any errant readings from an exhaust sniffer.

ENGINE TUNING GUIDELINES

Higher AFR values correspond to a leaner (less fuel) condition. The practical operating range for most
engines using gasoline fuel is from approximately 11.5 to 14.7 AFR. Combustion of a stoichiometric mixture
(exactly enough air to burn all the fuel) results in 14.7 AFR indication. Automotive engines with catalytic
converters operate near 14.7 AFR during cruise and idle. Air-cooled motorcycle race engines usually require a
richer mixture to limit cylinder head temperature and prevent detonation. Table 2 lists recommended AFR
values for race engines without emission controls.
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Recommended AFR Values

Operating Mode Recommended AFR

Cold Start (first 30 sec) | 11.5-12.5

Idle 12.8-13.5
Part Throttle Cruise 13.0-14.0
Wide Open Throttle 12.5-12.8 (values down

to 11.5 may be used to
reduce detonation)

EXHAUST CONSIDERATIONS

The use of a WEGO system for closed loop fuel control places constraints on the choice of exhaust system. The
WEGO system may give inaccurate results in certain situations:

Exhaust reversion. Reversion is the term for a negative pressure wave that can suck ambient air back
into the exhaust and cause an erroneous lean AFR indication. Reversion effects will be most noticeable at idle,
part throttle low RPM cruise, and decel. Open drag pipes suffer from reversion effects. Please note that if you
use drag pipes or other open pipes, auto-tuning may not be possible at idle or part throttle due to reversion
effects. In this case, you have three options:

1. Modify the exhaust to allow auto-tuning at idle and part throttle by adding a restriction such as the washers
shown in Figure 1 or some other type of baffling. For race applications, you can remove the restriction after
auto-tuning the idle and part throttle cells and then lock out closed loop operation by using the special value
0 in the BLM tables for these cells.

2. Use a rubber hose to extend the exhaust length during auto tuning at idle and part throttle. For more
information, please contact our tech support.

3. Manually tune the fuel tables for idle and part throttle cells. This involves trial and error and is not
recommended. Closed loop operation in idle and part throttle cells must be locked out by using the special
value 0 in the BLM tables for the affected cells.

You can reduce reversion effects in open drag pipes and mufflers without restrictive baffles with the
modification shown in figure below. Use washers with an OD that is 2/3 to 3/4 the ID of the pipe (for example,
1-1/2” OD washers are suitable for pipes with an ID of 2” to 2.25”). Weld 74-20 socket head cap screws to the
washers as shown. Drill holes at the bottom of the pipes about 2” from the end and use decorative acorn nuts to
secure the washer assemblies. We suggest that you use stainless steel hardware.

The washers will reflect positive pressure waves that will cancel out the negative pressure waves reflecting from
the end of the pipes. You can turn the washers just like throttle blades to provide more or less restriction. Dyno
tests will show a significant increase in midrange torque and a small drop in top end horsepower as the
restriction is increased.

Note: If you can insert a broomstick through the mufflers, you have the equivalent of open drag pipes
and the WEGO sensors will not read accurate AFR values, except at wide open throttle.

Reducing reversion effects in open drag pipes
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Excessive scavenging. Tuned exhausts in combination with a high overlap camshaft profile can pull unburned
air and fuel mixture through the cylinder into the exhaust and cause an erroneous rich AFR indication. Some
aftermarket 2-into-1 systems, such as the Thunderheader appear to suffer from this problem, whereas others
such as the Supertrapp seem less affected.

Misfiring. If the AFR is so rich that the engine misfires, high levels of oxygen will remain in the exhaust gas
and result in an erroneous lean indication.

HOT STARTING PROBLEMS

Some engines are prone to hot starting problems. When cranked after a short hot soak, the engine may “kick
back.” Over time, this will cause damage to the ring gear and starter pinion.

The TCFI module uses an improved starting algorithm that includes a programmable cranking delay. The TCFI
module is shipped with a zero-cranking delay: it fires on the first recognized compression stroke. This works
best on stock and mildly modified engines.

High compression engines will generally require compression releases. When compression releases are
installed, best starting results will be obtained by programming the TCFI module for a 1-2 revolution cranking
delay. This can be done by means of the PC Link TCFI software.

SPARK KNOCK PROBLEMS WITH HIGH COMPRESSION ENGINES

Spark knock problems may be encountered with high compression engines. If engine parts were “mixed and
matched” from different suppliers, the actual compression ratio may differ substantially from the expected
value. You cannot estimate compression ratio with cranking compression tests, as camshaft timing usually
causes an erroneous low reading.

To accurately calculate compression ratio, you must measure the combustion chamber volume and use the
formula:

Compression = (Head cc + Deck cc + Cylinder Volume)
Ratio (Head cc + Deck cc)
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The practical limit for compression ratio is about 10.5:1 to 11:1 when running 93 octane pump gas. Any higher
compression ratio will require retarding the ignition timing to the point where more power is lost from the
retarded timing than is gained from the higher compression.

If spark knock is encountered during operation, you can use the TCFI Log software to download data and
examine the operating conditions (RPM and manifold pressure) where spark knock occurred. You can then
make appropriate reductions to the ignition advance table. Large displacement, high compression engines are
prone to spark knock at relatively low MAP values during throttle roll-on. You may need to reduce the ignition
advance throughout the entire MAP range.

ACR SYSTEM

Engines on some models are equipped with an automatic compression release (ACR) system. The TCFI Gen 7
supports the ACR system. No modifications or other special considerations are required. The ACR output on
pin 19 of the ECM connector is active during the cranking revolutions set under Module Parameters (refer to
page 26) if this parameter is set to a non-zero value.

SUPPORT FOR TWINCOOLED™ ENGINES

2014+ engines that have factory liquid cooling systems can have full compatibility and adjustability with the
use of version 1.80 firmware and PC Link 18.1 and TCFI Log 18.1. No hardware changes are necessary;
however, you must have TCFI7 firmware version 1.80 to utilize the coolant pump and cooling fans (see TCFI
Gen 7 Rev 1.80 Firmware Update Tech Note).

The coolant pump will run when the engine is running, or when the conditions below exist:

Fans are turned on based on coolant temperature and vehicle speed. These are the stock settings:

Fan On Temp Below VSS : 105°C. This is the temperature setting that fans will turn from zero vehicle speed up
to the programmed vehicle speed.

Fan On Temp Above VSS: 118°C. This is the temperature setting at which the fans will remain on above the
programmed vehicle speed.

Speed for above Fan Settings 24 KPH. This is the vehicle speed breakpoint that the fan logic will follow to turn
on the fans.

Fan Off Hysteresis: 8°, any scale. This is a temperature hysteresis value so the cooling system doesn’t
constantly turn itself on/off.

When the engine is switched off and the cooling system needs to continue running (ex: Turbo Timer), the
following can be adjusted:

Engine Off Fan Timer: 180 seconds

Engine Off Cooldown Temp: 95°C

Finally, the coolant temperature, coolant pump operation, and fans operation are logged in version 18.1+ of the
TCFI Log software.

USER FUNCTIONS

The TCFI user input on pin 56 of the ECM connector can be connected for a stage RPM limit function as shown
in Figure 2. The stage limit switch must be normally open. You can use a microswitch attached to the clutch
lever. When the clutch lever is pulled in, the switch contacts should close to activate the stage RPM limit. Refer
to the User Functions section on page 28 for details on programming the stage RPM limit.
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Stage Limit Switch Wiring Diagram

STAGE LIMIT SWITCH OPERATION:
SWITCH OPEN - MAXIMUM RPM LIMIT
SWITCH CLOSED - STAGE RPM LIMIT TCFIGEN 7
[ ] BLACK CONNECTOR
| |0'/C| PIN 8 (USER INPUT)
TO GROUND

The TCFI user output on pin 20 of the ECM connector can drive a standard automotive relay connected as
shown in Figure 3. When the user output is active, +12V power is applied to the load. Refer to the User
Functions section on page 28 for details on programming the user output.

User Output Relay Wiring Diagram

TO +12V A
TCFIGEN 7 =
87
GRAY CONNECTOR 1 '
PIN 5 (USER OUTPUT) 1 30 1
86 85| 12V STANDARD
AUTOMOTIVE
RELAY
—> TO LOAD

CUSTOM BIKE AND AFTERMARKET ACCESSORY CONSIDERATIONS

Tight integration exists between the engine control module (ECM) and body control module (BCM) on Harley-
Davidson® models with CAN data bus. It is not possible to run one of these models without a BCM.

The original equipment ECM has no connector terminal assignment for a tach signal. Engine RPM data is only
available on the CAN data bus. Any aftermarket accessories that require engine RPM data will require an
appropriate CAN data bus interface.

TECH SUPPORT
If you require tech support for tuning issues, we will ask you to start a Tech Support ticket at:

https://support.jmschip.com/support-help/

Attach both the current setup file (downloaded by means of PC Link TCFI) and a data logging file (downloaded
by means of TCFI Log) that shows the problem. Please make sure that you include your full name, phone
number, complete information about the engine setup, and a detailed description of the problem. We suggest
that you call us first to discuss the situation.
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ENGINE DIAGNOSTICS

The TCFI Gen 8 version has extensive diagnostics. When the ignition switch is first turned on, the check engine
LED illuminates. The LED goes out when the system initialization is complete.

If a diagnostic fault is detected while the engine is running, the LED will illuminate. Diagnostic codes can be
read and cleared by means of the speedometer (same as with the OE ECM) or TCFI Log software. Most of the
diagnostic codes are the same as those used by H-D® and the H-D® Electrical Diagnostic Manual for your
model should be employed as a primary troubleshooting reference. Certain diagnostic codes that are unique to
the TCFI or require special consideration are listed below:

P0373 CKP Signal Lost. This code will appear if the engine stalls. Customers are often confused about
the meaning of the term “trips” associated with codes, especially P0373. This is an industry standard
terminology. If code P0373 shows 40 trips, it means that the code was set 40 engine start cycles ago, not
that the code has been set 40 times and that the crankshaft position sensor is defective.

P1607 refers to a diagnostic trouble code indicating a problem with the "Throttle Position Sensor (TPS)
Signal Out of Range. Pops up within 5 sec after start.

P0371 indicates a problem with the "Timing Reference High Resolution Signal A" which is typically
related to a faulty crankshaft position sensor, meaning the engine control module is detecting an abnormal
signal from the sensor regarding the engine's position, potentially causing issues with ignition timing and
fuel delivery; essentially, the bike's computer is not getting a clear signal about where the crankshaft is in
its rotation cycle.

Note: any time the bike starts, if the CEL stays on => it does not have cam sync (the ECU calculates cam
sync based on the cranking speed). Therefore, a pop at start or a weak battery will cause a sync issue. This
issue surfaces in about 5 seconds after the engine has been running.

Remedy: let the bike run a bit to warm up and charge the battery, then key off the ignition. Wait 30
seconds for all modules to turn off. Restart. Few seconds after starting the CEL will flash on/off; that is
normal.

How to tell if it is a sync issue or other problems: CEL will take longer to set is a sensor is faulty,
example: if O2 sensors are not connected, it will not set a code for 30 seconds — that’s how you can tell
the difference.

P0132 Rear Oxygen Sensor High, P0134 Rear Oxygen Sensor Low/Open, P0152 Front Oxygen
Sensor High, or P0154 Front Oxygen Sensor Low/Open. These codes indicate a problem with the
WEGO IID unit. P0134 and/or P0154 will be set if the WEGO signal connection (white and blue wires)
or WEGO power is lost. These codes may also be set if a Bosch sensor fails or becomes contaminated by
leaded gasoline.

If the engine “pings” on hot start => reduce PW in function table “Priming Fuel PW vs Engine temp”

Priming - Fuel PW vs Engine Temp - Fuel Injected Prior to Cranking

1
ETF | 3 | 32 [ & [ @ [ s 147 | 176 | 206 | 234 | 262 | 291 3o
PW msec | 33.02 26.08 18.43 8.45 4.86 3.07 2.05 1.02 1.02 1.02 1.02 12 1.02 1.02 1.02 1.02 1.02

REINSTALLING THE ORIGINAL EQUIPMENT ECM

Removal of the WEGO system is not required for simple operational tests such as verifying that the engine will
start and run.
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FAIL to START TROUBLESHOOTING FLOWCHAR

Experience has shown that most units returned for warranty are OK and another problem, such as user error
including improper setup or tuning, an intermittent wire harness connection, or defective coil, fuel injector, or
sensor is later identified.
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STARTING POINT

IS PROBLEM

REPLACE TCFI WITH OE MODULE OR
ANOTHER KNOWN GOOD MODULE.

FIXED?

YES I

NO

REINSTALL TCFI

REPAIR UNDERLYING PROBLEM
BEFORE INSTALLING TGFI. REFER
TO MOTORGYCLE SERVICE MANUAL

TURN IGNITION ON. SET ENGINE
SWITCH TO RUN. IS CHECK ENGINE
LED ILLUMINATED?

NO I YES

REPLACE TCFI

DOES ENGINE START?

NO I YES

I
REPLACE TCFI

DOES CHECK ENGINE LED REMAIN
ILLUMINATED OR ILLUMINATE AFTER
A SHORT TIME?

no |

YES

REFER TO ENGINE

APPLICABLE PROBLEM.

DIAGNOSTICS SECTION. FIX

DOES ENGINE STOP OR DROP
CYLINDER AFTER SEVERAL
MINUTES OF RUNNING?

NO I YES

]
REPLACE COIL.
IS PROBLEM FIXED?

ves | No
| ]

DOES ENGINE MISFIRE
UNDER LOAD?

REPLACE TCFI

NO

YES

REPLACE SPARK PLUGS,
SPARK PLUG WIRES, AND COIL
IS PROBLEM FIXED?

YES I NO
[ |

DONE REPLACE TCFI

DOES ENGINE MISFIRE
AT PART THROTTLE OR
WHILE COLD?

no |

YES

FOR MISC PROBLEMS,
CALL TECH SUPPPORT.

CHECK FOR INCORRECT COLD
START SETTINGS OR INTAKE
LEAK. IS PROBLEM FIXED?

ves | no
| ]

REPLACE TCFI

WEGO TROUBLESHOOTING FLOWCHART

Follow the troubleshooting flowchart shown below. Experience has shown that most units returned for warranty
are OK and another problem, such as user error, a degraded sensor, or bad power connections is later identified.

Daytona Twin Tec 240 Springview Commerce Dr BLD 1-J Debary, FL 32713

Tuning Guide PC_Link_TCFl.exe & TCFI_Log.exe Manual Rev 3.0 (386) 304-0700 www.daytona-twintec.com

Page 42


http://www.daytona-twintec.com/

NOTE: ALL TESTS PERFORMED
WITH SENSORS IN FREE AIR

STARTING
POINT

DO STATUS LEDS SLOWLY BLINK WHEN

POWER IS FIRST TURNED ON?
NO | YES
| |
VERIFY +12V POWER ON RED WIRE. DO STATUS LEDS CONTINUE SLOWLY
VERIFY BLACK WIRES CONNECTED TO BLINKING 60 SECONDS AFTER POWER
GROUND. IS PROBLEM FIXED? UP?
NO | YES Yes | No
| | |
REPLACE WEGO DONE PERFORM FREE AIR CALIBRATION.
IS CALIBRATION SUCCESSFUL?
Nol  YES
| |
MEASURE VOLTAGE LEVEL ON RED REPLACE SENSOR(S).
WIRE WITH DVM. IS IT GREATER THAN IS PROBLEM FIXED?
11 VOLTS?
NO | YES
I ves | NO I [ |
REPLACE SENSOR(S). | | WEGO REQURES MINIMUM 1 REPLACEWEGO | | DOKE
IS PROBLEM FIXED? VOLTS. FIX UNDERLYING PROBLEM
WITH VEHICLE ELECTRIC SYSTEM.
NO | YES
| | |
REPLACE WEGO DONE IS PROBLEM FIXED?
NO | YES
| |
CALL TECH SUPPORT DONE

COMMUNICATIUONS TROUBLESHOOTING FLOWCHART

Follow the troubleshooting flowchart shown below. Experience has shown that most communication problems
are user error or PC compatibility issues.
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STARTING
POINT

IS RS-232 TIMEOUT ERROR MESSAGE
DISPLAYED WHEN ATTEMPTING
DOWNLOAD OR UPLOAD?

YES NO

FOR MISC PROBLEMS,
CALL TECH SUPPORT.

CYCLE ENGINE RUN/STOP SWITCH.
VERIFY CHECK ENGINE LIGHT
ILLUMINATED. IS PROBLEM FIXED?

YES NO_

DONE

USE WINDOWS DEVICE MANAGER TO
VERIFY THAT CORRECT COM PORT IS
SELECTED. IS PROBLEM FIXED?

YES NO

DONE CALL TECH SUPPORT
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